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Preface

This section describes the purpose and organization of this guide: Getting Started
with the Oracle Management Pack for Oracle Applications. Specifically, it covers the
following topics:

■ Purpose of This Guide

■ Audience

■ How This Guide Is Organized

■ Oracle Enterprise Manager Pack Information

■ Oracle Enterprise Manager Documentation

Purpose of This Guide
This guide provides an overview of the Oracle Performance Manager and Oracle
Capacity Planner applications and their features. It also describes the Concurrent
Processing Tuning Assistant and the Oracle Applications Advanced Events. As the
guide describes how to use these applications and events, it also introduces you to
key concepts and terminology.

This guide also provides a brief description of all the Oracle Applications charts and
chart groups available in Oracle Performance Manager.

Audience
This guide is written for those who wish to use Oracle Performance Manager,
Oracle Capacity Planner, Concurrent Processing Tuning Assistant, and Oracle
Applications Advanced Events for managing Oracle Applications.
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This guide assumes that you are familiar with the Oracle Enterprise Manager
console and base applications. If you are not, please read Oracle Enterprise Manager
Concepts Guide and Oracle Enterprise Manager Administrator’s Guide.

This guide also assumes you have some administrative knowledge of Oracle
Applications. If not, please refer to the Oracle Applications documentation.

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Overview"

Provides an overview of the Oracle Management Pack for Oracle Applications and
its features.

Chapter 2, "Post-Installation Configuration"

Provides lists of steps to consider after the installation of the Oracle Management
Pack for Oracle Applications has taken place.

Chapter 3, "Introduction to Oracle Performance Manager"

Provides an overview of the Oracle Performance Manager application and its
features.

Chapter 4, "Introduction to Oracle Capacity Planner"

Provides an overview of the Oracle Capacity Planner application and its features.

Chapter 5, "Concurrent Processing Tuning Assistant"

Provides an overview of the Concurrent Processing Tuning Assistant feature.

Chapter 6, "Oracle Applications Advanced Events"

Provides an introduction to the Oracle Applications Advanced Events.

Chapter 7, "Oracle Applications Jobs"

Describes Oracle Applications jobs.

Appendix A, "Charts and Chart Groups"

Provides a description of the charts and chart groups available with Oracle
Performance Manager.

Appendix B, "Remote Data Gatherer Configuration"
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Provides information on how to configure the Data Gatherer to point to an Oracle
Applications instance located on a remote node.

Appendix C, "Troubleshooting"

Provides solutions to problems you may encounter while working with the
Management Pack for Oracle Applications.

Oracle Enterprise Manager Pack Information
The Oracle Enterprise Manager product family includes six packs: Oracle Change
Management Pack, Oracle Diagnostics Pack, Oracle Tuning Pack, Oracle Standard
Management Pack, Oracle Management Pack for SAP R/3, and Oracle Management
Pack for Oracle Applications. Each pack is fully integrated into the Oracle
Enterprise Manager Console framework.

Oracle Change Management Pack

■ Includes DB Alter, DB Capture, DB Diff, DB Propagate, DB Quick Change, DB
Search, and Plan Manager.

■ Tracks metadata changes in databases.

■ Eliminates errors and loss of data when upgrading databases to support new
applications.

■ Analyzes the impact and complex dependencies associated with application
change and automatically performs database upgrades.

■ Allows you to find the database objects that match a set of search criteria that
you specify.

■ Initiates change with easy-to-use wizards that teach systematic steps necessary
to upgrade databases.

Oracle Diagnostics Pack

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Trace,
Oracle TopSessions, and Oracle Advanced Event Tests.

■ Monitors, diagnoses, and maintains the stability of databases, operating
systems, and applications. Both historical and real-time analysis are used to
automatically avoid problems before they occur.

■ Provides powerful capacity planning features that enable users to easily plan
and track future system resource requirements.

Oracle Tuning Pack
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■ Includes Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning Wizard, and
Oracle Tablespace Manager.

■ Optimizes system performance by identifying and tuning major database and
application bottlenecks such as inefficient SQL, poor data structures, and
improper use of system resources.

■ Discovers tuning opportunities and automatically generates the analysis and
required changes to tune the system. Inherent in the product are powerful
teaching tools that help DBAs learn to tune the system as they work.

■ Helps increase developers and DBAs productivity.

Oracle Standard Management Pack

■ Includes Oracle DB Capture, Oracle DB Diff, Oracle Index Tuning Wizard,
Oracle Performance Manager, and Oracle TopSessions.

■ Monitors and diagnoses problems, tunes high impact indexes, and tracks and
compares changes in your Oracle environment.

Oracle Management Pack for SAP R/3

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle
Event Tests that are specific to monitoring your SAP R/3 environment.

■ Monitors, diagnoses, and maintains the health of a SAP R/3 system. Both
historical and real-time analysis are used to automatically avoid problems
before they occur.

■ Provides powerful capacity planning features that enable users to easily plan
and track future system resource requirements.

Oracle Management Pack for Oracle Applications

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Concurrent
Processing Tuning Assistant, and Oracle Applications Event Tests.

■ Enables you to monitor all aspects of your system, including databases and
concurrent managers.

■ Enables the monitoring, diagnosing, and capacity planning of the Oracle
Applications environment.

Oracle Enterprise Manager Documentation
Getting Started with the Oracle Management Pack for Oracle Applications is one of
several Oracle Enterprise Manager documents.
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Oracle Enterprise Manager Base Documentation

■ Oracle Enterprise Manager Readme provides important notes regarding the online
documentation, updates to the software, and other late-breaking information.

■ Oracle Enterprise Manager Installation CD-ROM insert provides information
about installing Oracle Enterprise Manager.

■ Oracle Enterprise Manager Administrator’s Guide explains how to use Oracle
Enterprise Manager, the Oracle systems management console, common
services, and integrated platform tool.

■ Oracle Enterprise Manager Concepts Guide provides an overview of Oracle
Enterprise Manager.

■ Oracle Enterprise Manager Configuration Guide explains how to configure Oracle
Enterprise Manager.

■ Oracle Enterprise Manager Messages Manual describes Oracle Enterprise Manager
error messages and methods for diagnosing the errors.

Oracle Change Management Pack Documentation

■ Oracle Change Management Pack Readme provides important notes regarding the
Change Management Pack online documentation, updates to the software, and
other late-breaking information.

■ Oracle Change Management Pack Installation CD-ROM insert provides
information about installing Oracle Change Management Pack.

■ Oracle Enterprise Manager Getting Started with Oracle Change Management Pack
provides an overview of the concepts and features of Oracle Change
Management Pack applications.

Oracle Diagnostics Pack Documentation

■ Oracle Diagnostics Pack Readme provides important notes regarding Diagnostics
Pack online documentation, updates to the software, and other late-breaking
information.

■ Oracle Diagnostics Pack Installation CD-ROM insert provides information about
installing Oracle Diagnostics Pack.

■ Oracle Enterprise Manager Performance Monitoring and Planning Guide provides an
overview of the concepts and features of Oracle Performance Manager, Oracle
Capacity Planner, and Oracle TopSessions applications. It also describes Oracle
Event Tests that are provided with the Oracle Diagnostics Pack, which allow
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you to implement automatic problem detection and correction on databases,
listeners, and nodes.

■ Oracle Enterprise Manager Oracle Trace User’s Guide explains how to use Oracle
Trace to capture and use historical data to monitor Oracle databases.

■ Oracle Enterprise Manager Oracle Trace Developer’s Guide explains how to
instrument your application with Oracle Trace routines.

Oracle Tuning Pack Documentation

■ Oracle Tuning Pack Readme provides important notes regarding Tuning Pack
online documentation, updates to the software, and other late-breaking
information.

■ Oracle Tuning Pack Installation CD-ROM insert provides information about
installing Oracle Tuning Pack.

■ Oracle Enterprise Manager Database Tuning with the Oracle Tuning Pack provides
an overview of the concepts and features of each of the applications in Oracle
Tuning Pack. The applications include Oracle SQL Analyze, Oracle Expert,
Oracle Index Tuning Wizard, and Oracle Tablespace Manager. A description of
how these applications can work together to tune an Oracle database is also
provided.

Oracle Standard Management Pack Documentation

■ The Oracle Standard Management Pack Readme provides important notes
regarding the Oracle Standard Management Pack online documentation,
updates to the software, and other late-breaking information.

■ The Oracle Standard Management Pack Installation CD-ROM insert provides
information about installing the Oracle Standard Management Pack.

■ The Oracle Enterprise Manager Getting Started with the Oracle Standard
Management Pack provides an overview of the concepts and features of Oracle
DB Capture, Oracle DB Diff, Oracle Index Tuning Wizard, Oracle Performance
Manager, and Oracle TopSessions.

Oracle Management Pack for SAP/R3 Documentation

■ Oracle Management Pack for SAP/R3 Readme provides important notes regarding
Oracle Management Pack for SAP R/3 online documentation, updates to the
software, and other late-breaking information.

■ Oracle Management Pack for SAP R/3 Installation CD-ROM insert provides
information about installing Oracle Management Pack for SAP/R3.
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■ Getting Started with the Oracle Management Pack for SAP/R3 provides an overview
of the concepts and features of Oracle Performance Manager and Oracle
Capacity Planner. It also describes Oracle Event Tests that are provided with the
Oracle Management Pack for SAP/R3.

Oracle Management Pack for Oracle Applications Documentation

■ Oracle Management Pack for Oracle Applications Readme provides important notes
regarding Oracle Management Pack for Oracle Applications online
documentation, updates to the software, and other late-breaking information.

■ Oracle Management Pack for Oracle Applications Installation CD-ROM insert
provides information about installing Oracle Management Pack for Oracle
Applications.

■ Getting Started with the Oracle Management Pack for Oracle Applications provides
an overview of the concepts and features of Oracle Performance Manager,
Oracle Capacity Planner, and Concurrent Processing Tuning Assistant. It also
describes Oracle Applications Event Tests and Jobs that are specific to
monitoring your Oracle Applications environment.

■ Oracle Intelligent Agent User’s Guide provides configuration information and
answers to crucial troubleshooting questions pertaining to the Oracle Intelligent
Agent.
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1
Overview

The sheer complexity of enterprise application systems presents you, the Oracle
Applications system administrator, with much greater challenges than managing
the database by itself. The Oracle Management Pack for Oracle Applications
(hereafter referred to as the Management Pack for Oracle Applications) helps you
better manage your systems through a single console, from which you can monitor
and administer all major aspects of the system, including databases and concurrent
managers.

The Management Pack for Oracle Applications extends Oracle Enterprise Manager
to enable the monitoring, diagnosing, and capacity planning of the multitiered
Oracle Applications environment. The Management Pack for Oracle Applications
takes advantage of the following Oracle Enterprise Manager system management
features:

■ Discovery and graphical representation of services to be monitored

■ Starting tools from the console in the context of a specific service

■ Automated data collection and management services

■ Central monitoring and administration of remote systems using intelligent
agents

The Management Pack for Oracle Applications extends the following tools to work
with Oracle Applications:

■ Oracle Enterprise Manager console

The console is extended to discover concurrent managers and to notify you
should any of the servers go down. You can also define jobs for any of the
Oracle Applications subsystems, allowing central administration of a
distributed Oracle Applications system.

■ Oracle Applications Advanced Events
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A library of events specific to Oracle Applications are provided for lights-out
event monitoring and problem detection of the Oracle Applications system.

Additional lights-out problem resolution is provided with fix-it jobs that are
configured to run automatically when an event triggers. These fix-it jobs are
either custom-built or chosen from a small predefined set provided with the
Management Pack for Oracle Applications.

■ Oracle Performance Manager

A new Oracle Applications data gatherer cartridge feeds data to Oracle
Performance Manager, providing you with an extensive array of real-time
monitoring charts on all concurrent managers and Forms sessions that are used
by your Oracle Applications instance.

■ Oracle Capacity Planner

Concurrent manager performance data is gathered over time and fed to Oracle
Capacity Planner for analysis of resource consumption and detection of
performance anomalies.

■ Concurrent Processing Tuning Assistant

This utility allows you to examine historical processing information about
Oracle Concurrent Processing requests and concurrent managers.

This chapter investigates the interaction of each of these tools with Oracle
Applications.

Oracle Enterprise Manager Console
Concurrent Manager servers can be discovered in the Oracle Enterprise Manager
navigator. By discovering all databases and Concurrent Manager servers available
on the system, Oracle Enterprise Manager provides a single point of administration
for an Oracle Applications system. The integration with Oracle Enterprise Manager
provides the benefits of the existing 3-tiered management infrastructure and
provides you with a familiar interface thus reducing the learning curve.

Note: For information on installing and configuring the Intelligent
Agent, the Oracle Data Gatherer, and the Oracle Management
Server, see the Oracle Enterprise Manager Configuration Guide and
Chapter 2, "Post-Installation Configuration".
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Central Administration of Oracle Applications System
You can group together discovered services into a single logical entity, such as the
Production Financials System or the Human Resource Test System. Once grouped,
you can quickly identify which system is affected when a particular Oracle Forms
server goes down, or easily link the slow performance of a particular application
with an overloaded concurrent manager in that system.

The base Enterprise Manager console ships with simple events for Oracle
Applications, allowing you to check whether the relevant subsystems are up or
down, and have notifications delivered by a pager or e-mail to the appropriate
administrators identified by their job responsibilities and work shifts. This
capability allows you not only to detect problems before an end user does, but also
to do so when you are not even in the office!

Automatic Problem Resolution
The base console also is shipped with a library of predefined jobs specific to Oracle
Applications, such as shutting down or starting up a remote server. These jobs can
be configured to trigger automatically as fix-it jobs for particular events, or
scheduled to run at predefined times or intervals. As a result, you can automatically
correct problems before end users are aware of them.

Oracle Applications Advanced Events
In addition to the basic UpDown events provided for all services administered in
the Oracle Enterprise Manager console, the Management Pack for Oracle
Applications provides a library of advanced events specific to Oracle Applications
subsystems. Examples of the problems that the events notify you of include:

■ Internal Concurrent Manager is waiting on a lock.

■ Percentage of requests with errors has exceeded a threshold.

■ Run-alone request was submitted, locking out all other requests.

See Chapter 6, "Oracle Applications Advanced Events" for a complete list of these
problems.

The key to smooth system administration is to resolve problems before they turn
into crises. These advanced events allow you to focus on the causes of a problem
before the symptoms become serious. In addition, with pager and e-mail
notification mechanisms provided by Oracle Enterprise Manager, you can be
notified of any problems with the system wherever you are located.
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Oracle Performance Manager
The Management Pack for Oracle Applications uses Oracle Performance Manager, a
tool also available as part of the Oracle Diagnostics Pack. Oracle Performance
Manager has been extended to monitor the performance statistics of concurrent
managers.

Oracle Performance Manager displays performance data in real-time graphical
views that can be automatically refreshed at user-defined intervals. Multiple charts
and tables can be presented in a single monitoring window, affording you a
multifaceted view to applications system performance. For example, an Oracle
Applications administrator can monitor the number of Oracle Forms sessions,
pending concurrent requests, and the number of running concurrent requests all in
a single screen. The following are some of the predefined overview chart groups
shipped with the Management Pack for Oracle Applications:

■ System Activity Overview Chart Group

– Forms Sessions and Concurrent Requests Chart

– Completed Requests by Status Chart

– Pending Requests per Manager Chart

– Running Requests per Manager Chart

– Longest Running Requests Chart

■ Top Resource Consumers Chart Group

– Top Form Sessions Chart

– Top Running Requests Chart

Users can further drill down on these charts to see greater detail, and in some cases,
drill down to problematic requests and terminate them. Many other subsystem
specific charts are available, giving you a rich set of data to analyze your system
from multiple angles. See Appendix A, "Charts and Chart Groups" for a description
of individual charts.

Oracle Capacity Planner
The same data collection mechanism used by Oracle Performance Manager is also
used to collect historical performance and resource consumption data for capacity
planning. The Management Pack for Oracle Applications uses Oracle Capacity
Planner to analyze concurrent manager performance data to help you configure
your systems appropriately and project your future capacity needs.
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Historical data can be gathered for many charts exposed in the Oracle Performance
Manager. This collection can be customized, allowing you to select any subset of
statistics to collect and the interval at which these statistics should be sampled. The
data collection mechanism allows you to customize roll up capabilities, where data
can be aggregated at the end of each hour, day, week, or month. This data collection
mechanism, along with data expiration policies you customize, gives you full
control over the amount of storage needed for the historical data.

Once the data is gathered, you can use Oracle Capacity Planner to chart the
historical data for the purposes of identifying trends and predicting future
hardware requirements for the system. You can also extrapolate to a particular point
in time or work back from a particular target value and find when that event is
expected to occur. These charts can be customized, allowing you to get the data you
need and to view data from multiple sources (for example, CPU, disk, and
concurrent manager processes) on a single, unified chart.

Concurrent Processing Tuning Assistant
The Concurrent Processing Tuning Assistant reports historical information about
concurrent managers, concurrent programs, and concurrent processing requests.
You can use these reports to achieve better throughput and performance.

Unlike other Management Pack for Oracle Applications tools, the Tuning Assistant
does not connect to the Oracle Management Server. Instead you log in directly to
the database schema containing the Oracle Application Object Library tables for the
subsystems you want to tune.

The Tuning Assistant reports help you balance concurrent manager workloads by
determining:

■ Time periods with greatest wait times

■ Requests that waited during those time periods

■ Time periods with excess concurrent manager capacity

You can then reschedule requests that waited, add more concurrent managers, or, if
necessary, add more hardware to address the problem.

Many reports allow you to drill down to other reports associated with the selected
item(s). For example, when you run the Waiting Requests by Hour report, you can
quickly determine the time period with the greatest wait times. You can then select
the period, drill down to the Requests that Waited report, and identify the requests
that were blocked.
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2
Post-Installation Configuration

After you have installed the Management Pack for Oracle Applications, you need to
configure software on the following nodes:

■ Managed node (for example, Concurrent Manager Server node)

■ Oracle Management Server node

■ Client node

The following sections provide detailed information about each of these
configuration tasks.

Note: All the configuration tasks listed in this chapter are required
to bring the Management Pack for Oracle Applications online. A
checklist is provided at the end of this chapter to help you ensure
that each step has been performed correctly.
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Managed Node
On the managed node you must:

❏ Apply Oracle Applications patch for bug #730116 or bug #901809, depending on
the version of your Oracle Applications instance

❏ Configure Net8 (SQL*Net) for the Intelligent Agent’s Oracle home

❏ Verify Net8 configuration in the Intelligent Agent’s Oracle home

❏ Configure the oapps.ora file for discovery of Oracle Applications

❏ Configure Windows NT security for the Enterprise Manager job system

❏ Enable disk statistics collection for Capacity Planner and Performance Manager
on Windows NT (for Windows NT only)

❏ Configure Oracle Applications Sign-On Auditing profile

❏ Verify the configuration of the managed node

Applying Oracle Applications Patch for Bug #730116 or Bug #901809
The patch for bug #730116 or bug #901809 must be applied to the Oracle
Applications instance for it to be managed by the Management Pack for Oracle
Applications. The patch for bug #730116 applies to release 10.7 of Oracle
Applications and the patch for bug #901809 applies to release 11.0 of Oracle
Applications. These patches must be applied to the $APPL_TOP directory of each of
the Concurrent Processing Servers.

Note: If you are running the Concurrent Processing Server in
Parallel Concurrent Processing mode (that is, distributed across
several host computers), configure as a managed node only the host
which runs the Internal Concurrent Manager. In this configuration,
the Applications Disk Free event will only report on the disk space
on this node.

Note: The fix for bug #730116 is a server-side patch, which applies
identically to 10.7 SC (Smart Client), 10.7 NCA (Network
Computing Architecture), and 10.7 character mode deployments.
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As a convenience, the US_ENGLISH versions of patches for bug #730116 and bug
#901809 for Oracle Applications are supplied on the Management Pack for Oracle
Applications CD-ROM for the following operating systems:

You will find these patches in the top-level directory labeled "Applications Patches".
If you require these patches for other languages or operating systems, or are
otherwise unable to install these patches from this media, please use your normal
channels for pulling patches for Oracle Applications. The patch for bug #730116 or
bug #901809 is a prerequisite for using the Management Pack for Oracle
Applications.

Operating System Oracle Applications Version

Patch for Bug #730116

DIGITAL_UNIX 10.7

HP-UX_11.0.32bit 10.7

HP-UX_98XX 10.7

IBM_RS_6000_AIX 10.7

INTEL_SVR4_UNIX_SOLARIS 10.7

INTEL_WINDOWS_NT 10.7

SILICON_GRAPHICS_UNIX 10.7

SUN_SPARC_SOLARIS 10.7

Patch for Bug #901809

DIGITAL_UNIX 11.0

HP-UX_11.0.32bit 11.0

IBM_RS_6000_AIX 11.0

INTEL_SVR4_UNIX_SOLARIS 11.0

INTEL_WINDOWS_NT 11.0

SILICON_GRAPHICS_UNIX 11.0

SUN_SPARC_SOLARIS 11.0
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Configuring Net8 in the Intelligent Agent’s Oracle Home
The Intelligent Agent on the managed node must be able to make a Net8 connection
to the Oracle Applications instance database. One method of configuring the
Intelligent Agent is to have an entry for this database in the tnsnames.ora file in the
Intelligent Agent’s $ORACLE_HOME/network/admin directory. Refer to the Net8
documentation for details.

When you configure tnsnames.ora, use a fully qualified TNS entry for the name of
your Applications database, such as "mydatabase.world" or
"mydatabase.acme.com". If your Net8 configuration does not have a domain, that is,
a domainless configuration, the TNS alias in the tnsnames.ora file must be
terminated with a period. At a later step, you will need to enter exactly this fully
qualified name into the oapps.ora file.

This tnsnames.ora file also needs an entry for the database you will be using for
storing capacity planning data. When you use Oracle Capacity Planner, you will be
prompted for the name of this database, which must be reachable through SQL*Net
from the Intelligent Agent’s Oracle home. If you know which database you will be
using for capacity planning data, now is a good time to add this entry to the
tnsnames.ora file. Otherwise, you will need to add this database to the tnsnames.ora
file of this Intelligent Agent’s Oracle home before you first use Oracle Capacity
Planner.

Note: On Solaris, if an /etc/tnsnames.ora file or a
/var/opt/oracle/tnsnames.ora file exists, you must edit this file
rather than the $ORACLE_HOME/network/admin/tnsnames.ora
file.

Also, if the TNS_ADMIN environment variable is set, then you
must edit the $TNS_ADMIN/tnsnames.ora file rather than any
other tnsnames.ora file.
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Verifying Net8 Configuration in the Intelligent Agent’s Oracle Home
Verify that you can connect to the Oracle Applications instance from the Intelligent
Agent’s Oracle home. Type sqlplus <user>/<password>@<apps_dbname>  to
confirm that the database instance can be reached. The <apps_dbname> you use in
this verification step must be the same fully qualified tns name you created.
Additionally, verify Net8 connectivity to your Capacity Planner repository
database, if you created a tnsnames.ora entry for the database.

Configuring the oapps.ora File
You must configure the oapps.ora file so that the Intelligent Agent can discover the
Concurrent Manager Server. The oapps.ora file is installed into the following
directory in the Intelligent Agent’s Oracle home:

$ORACLE_HOME/network/agent/config

The oapps.ora file is an input file used to associate Oracle Applications instances
with information about the instances.

Note: If you create the tnsnames.ora address using the Net8
administration tools:

■ On Windows NT, use the Net8 Configuration Assistant. Do not
use the Net8 Easy Config or Net8 Assistant for this purpose.

■ On Solaris, use the netca tool, rather than the netec tool or the
netasst tool, from the Intelligent Agent’s OracleHome/bin
directory.

Note: If you are using Oracle Names or another name service for
your Net8 naming, ensure that the fully-qualified names of your
applications database have been entered into your name server.

Note: If you are using an Intelligent Agent release 8.0.6, you may
not have the SQL*Plus executable installed in your Intelligent
Agent’s Oracle home. If this is the case, you can install the
executable from the same media you used to install the Intelligent
Agent.
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The file format is:

<type> <WS> <dbname> <WS> <envfile> <WS> <startup information> <NL>

Lines starting with "#" as the first non-WS character are comments and are ignored.

An example of the sample entry for Windows NT is:

Variable Definition

<type> Entry type - Currently only "cmanager" is recognized; cmanager
denotes Concurrent Manager Server.

<WS> White space (one or more blanks or tabs)

<dbname> Applications database name. This name is also used as the
Applications instance name. This must be exactly the same (fully
qualified) name as used when configuring and verifying the
Net8 connectivity to your applications database.

<envfile> Fully qualified path to the Applications environment file. This
file must set up the entire Applications environment, including
all required database environment variables, and all variables
from the Applications environment file located in the APPL_
TOP directory.

Note: For the Windows NT 10.7 instance, which does not have
the Applications environment file, create an empty file under the
APPL_TOP directory.

<startup information> For Windows NT - Name of the ICM service in the NT Services
panel

For UNIX - Fully qualified path to the ICM startup script.
Typically this is the oemstart.sh  script in the $FND_TOP/bin
directory, installed when you apply the patch for bug #730116 or
bug #901809.

<NL> New line, that is, one line per entry

Note: The <dbname> field must work as a Net8 connect alias to
the database used by this Applications instance, that is, the alias
must be present in the tnsnames.ora file or other
name-to-tnsaddress lookup mechanism used from this host. This
entry should be a fully-qualified TNS name. For example, if the
tnsnames.ora file entry is "a.world", the oapps.ora file entry must
also be "a.world".
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# entry for discovering the headquarters production applications instance
cmanager hqprod.world C:\home\admin\appsenvfile ICMprod

An example of the sample entry for UNIX is:

# entry for discovering the headquarters production applications instance
cmanager hqprod.world /appltop/APPLSYS.env /appltop/fnd/11.0/bin/oemstart.sh

Configuring Windows NT Security for the Enterprise Manager Job System
You can use the Oracle Intelligent Agent to perform a variety of jobs on the
managed node, such as starting or stopping the concurrent manager, or running
fixit jobs to correct problems detected by Advanced Events.

To use this feature, you must grant the Windows NT Log on as a batch job privilege
to the Windows NT user whose account will be used to run these jobs. If you know
what user account(s) you will be using for this purpose, configure them now. If not,
perform this step later when you enter preferred node credentials to be used on this
node by Oracle Enterprise Manager.

To grant a Windows NT user the Log on as a batch job privilege, do the following:

1. Select Start=>Programs=>Administrative Tools=>User Manager.

2. Highlight the user to be granted the privilege.

3. Choose Policies=>User Rights.

4. Check the Show Advanced User Rights box.

5. In the Right field, select to the Log on as a batch job right.

6. Click Add.

Jobs submitted using user names without the Log on as a batch job privilege fail
with the status of "Vni Authentication Error".

Enabling Disk Statistics Collection for Capacity Planner and Performance Manager
on Windows NT

To collect disk statistics on Windows NT, type the following at a DOS prompt:

diskperf  -Y

Important: You must restart the Intelligent Agent after changing
the oapps.ora file.
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Disk statistics will be enabled the next time the system is restarted.

Configuring Oracle Applications Sign-On Auditing
To monitor Applications form sessions with the Management Pack for Oracle
Applications, you must set the Oracle Applications Sign-On:Audit Level profile to
FORM, using your normal Applications administration tools. Oracle suggests that
you periodically run the Purge Signon Audit Data concurrent program to purge
unwanted historical data from your FND tables.

Verifying the Configuration of the Managed Node
To verify that the configuration was successful, start the Intelligent Agent and the
Intelligent Agent Data Gatherer, as explained in the following sections:

■ Managing the Intelligent Agent on UNIX on page 2-9

■ Managing the Intelligent Agent on Windows NT on page 2-10

■ Managing the Intelligent Agent from the Windows NT Command Prompt on
page 2-10

■ Managing the Data Gatherer on UNIX on page 2-11

■ Managing the Data Gathering Service on Windows NT on page 2-11

After starting the Intelligent Agent, verify that the Intelligent Agent successfully
discovered the concurrent manager by inspecting the Intelligent Agent’s
$ORACLE_HOME/network/agent/services.ora file. This file should contain an
entry of the form:

<applications instance name> = (oracle_sysman_cmanager, <hostname>, <environment
file name>, <startup information>)

Note: If you want to view CPU usage of your concurrent
programs using Performance Manager, the applications database
must have the Timed Statistics parameter, located in the oracle.ini
file, turned on. See your database documentation for details.
Activating this parameter may have a performance impact on your
database.
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If such a line does not appear in the service.ora file, refer to Appendix C,
"Troubleshooting", or the Oracle Intelligent Agent User’s Guide for additional
information.

Managing the Intelligent Agent on UNIX
On UNIX, Oracle Enterprise Manager uses the lsnrctl command to start and stop
the Intelligent Agent. The relevant lsnrctl  commands to control the UNIX
Intelligent Agent are listed in the following table.

Note: Verify that your Oracle home environment variable is set to
the Intelligent Agent’s Oracle home before running lsnrctl. Also,
Oracle suggests you perform the following steps:

■ Construct an environment file for use with this agent separate
from the environment files you use for other Oracle
Applications on this node.

■ Ensure that the PATH variable includes the $ORACLE_
HOME/bin directory and that the LD_LIBRARY_PATH
variable includes the $ORACLE_HOME/lib directory for this
agent’s Oracle home. These directories must be at the
beginning of their respective lists of directories.

■ Do not set any values for the ORA_NLS and ORA_NLS33
environment variables. You will run into trouble if these are set
to the directories Oracle Applications uses for these variables.

■ If the agent is using the tnsnames.ora file in its own Oracle
home, do not set your TNS_ADMIN environment variable.

If you want to... Enter the command...

Start the agent on UNIX platforms lsnrctl dbsnmp_start

Stop the agent on the UNIX platform lsnrctl dbsnmp_stop

Verify status of the agent lsnrctl dbsnmp_status

or

ps -ef|grep dbsnmp

Verify there are two "dbsnmp" processes.
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Managing the Intelligent Agent on Windows NT
On Windows NT, the Intelligent Agent runs as a Windows NT service. The steps to
control the Intelligent Agent are listed in the following table.

In the Windows NT Services panel, the Intelligent Agent Startup Type is set by
default to Manual. This allows the Intelligent Agent to be started by a user. If you
want the Intelligent Agent to start automatically whenever you start the system, set
the Startup Type to Automatic. Refer to the Oracle Intelligent Agent User’s Guide for
additional information.

Managing the Intelligent Agent from the Windows NT Command Prompt
To start or stop the Intelligent Agent from the command prompt, enter the
appropriate command. From the command prompt, you can also verify that the
service is running.

The <agent service> is composed of the word "Oracle", followed by the name of the
Oracle home (for example, OUIHome), and concluded with the word "Agent" with
a number attached. OracleOUIHomeAgent80 , is an example of an agent service.

If you want to... Do the following...

Start Intelligent Agent Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>Agent=>Start

Stop Intelligent Agent Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>Agent=>Stop

Verify status of Intelligent
Agent

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>Agent=>look at Status column

or

View the Windows NT Task Manager to see the dbsnmp.exe
process information

If you want to... Enter the following command

Start the Intelligent Agent from the prompt net start <agent service>

Stop the Intelligent Agent from the prompt net stop <agent service>

Verify status of the Intelligent Agent from the prompt net start
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Managing the Data Gatherer on UNIX
On UNIX, Oracle Enterprise Manager uses the vppcntl  command to manage the
Data Gatherer. The vppcntl  executable is located in the ORACLE_HOME/bin
directory.

Commands to control Oracle Data Gatherer are listed in the following table.

Managing the Data Gathering Service on Windows NT
On Windows NT, the Data Gatherer runs as a Windows NT service. The steps to
control Oracle Data Gatherer are listed in the following table.

Note: Do not use the lsnrctl command to start the Intelligent Agent for
Windows NT.

Note: The same environment variable considerations apply when
running the Data Gatherer as when running the Intelligent Agent.
See the note in the section titled "Managing the Intelligent Agent on
UNIX" on page 2-9 for additional details.

If you want to... Enter the command...

Start Oracle Data Gatherer vppcntl -start

Stop Oracle Data Gatherer vppcntl - stop

Verify that Oracle Data Gatherer is
running

vppcntl -ping

or

ps -ef | grep vppdc

Identify the version of Oracle Data
Gatherer

vppcntl -version

Run Oracle Data Gatherer in
debug mode

vppdc -console -debug

The Data Gatherer needs to be stopped before
executing this command. The debug output will be
printed to the user’s terminal window, not a log file.
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If you want to... Do the following...

Start Oracle Data
Gatherer

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>DataGatherer=>Start

or

Open an MS-DOS window and type the command:

vppcntl -start

Stop Oracle Data
Gatherer

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>DataGatherer=>Stop

or

Open an MS-DOS window and type the command:

vppcntl -stop

Verify that Oracle Data
Gatherer is running

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>DataGatherer=>look at Status column to verify that
the service is started

or

Check Task Manager for process running vppdc.exe

or

Open an MS-DOS window and type the command:

vppcntl -ping

Identify the version of
Oracle Data Gatherer

Open an MS-DOS window and type the command:

vppcntl -version

Run Oracle Data
Gatherer in debug
mode

Open an MS-DOS window and type the command:

vppdc -console -debug

The Data Gatherer needs to be stopped before executing this
command. The debug output will be printed to the user’s
terminal window, not a log file.
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Oracle Management Server (OMS) Node
After you install the Oracle Management Server for the Management Pack for
Oracle Applications, you must:

❏ Create the Oracle Management Server repository

❏ Register the Management Pack for Oracle Applications extensions to the Oracle
Management Server

❏ Verify the configuration of the Oracle Management Server

❏ (Optional) Run the Management Pack for Oracle Applications from a web
browser

Creating the Oracle Management Server Repository
When you create your Oracle Management Server, you must provide the repository
address in the <host:port:sid> format, rather than using a Net8 service name or
leaving the name field blank to indicate a local default database. The host portion
should be a fully qualified DNS name, for example, myhost.us.acme.com .
Otherwise, Capacity Planner and Performance Manager clients from other DNS
domains (for example, uk.acme.com) will not be able to connect to the server. This
step ensures that all Enterprise Manager applications can connect to the Oracle
Management Server repository when needed.

If you are using a previously created repository, use the Enterprise Manager
Configuration Assistant to verify that the Oracle Management Server is using the
<host:port:sid>  syntax for its repository address, and modify it to use this
syntax if needed. To do this task, start the Configuration Assistant, as follows:

■ To start the Configuration Assistant on Windows NT, select
Start=>Programs=><Enterprise Manager Home>=>Oracle Enterprise
Management=>Enterprise Manager Configuration Assistant

■ To start the Configuration Assistant on UNIX, run <Enterprise Manager Oracle
Home>/bin/emrepmgr

Select the Edit Configuration Parameters option and click Next.

The existing Oracle Management Server connection parameters are now displayed.
The bottom parameter ("Service") indicates the repository service. If this is already
in the <host:port:SID> syntax, nothing further need be done, and you can exit the
tool.
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If this line instead contains a name (for example, "omsdb" or "omsdb.acme.com") or
is blank, you need to do the following:

1. Change the line to contain the fully-qualified host name that the Oracle
Management Server repository database is running on. Insert a colon after the
host name.

2. Type the port number that the TNS listener for this database is using. Insert a
colon after the port number.

3. Type the SID of this database. The resulting line looks like:

omhost.acme.com:1521:ORCL

4. Click Next.

5. Click Finish to save the changes.

Registering the Management Pack for Oracle Applications Extensions
If you are using a preexisting Oracle Management Server repository which you
created using the Enterprise Manager release 2.0 CD-ROM, you must register the
Oracle Applications Management extensions to this repository. However, if you
created your Oracle Management Server repository using the Management Pack for
Oracle Applications CD-ROM, skip this step.

To register the Applications Management extensions, first ensure that the database
where you registered the Enterprise Manager repository is up and functioning
properly, but that the Oracle Management Server is not running. Then, on UNIX,
run the following script:

$ORACLE_HOME/sysman/admin/regappsmgmt.sh <OMS connect string>

On Windows NT, run:

$ORACLE_HOME\sysman\admin\regappsmgmt.bat <OMS connect string>

The <OMS connect string> is the repository user name, password, and Net8
Connect Alias you entered when creating the Enterprise Manager repository, for
example:

repository_owner/repository_pwd@myhost.acme.com:1521:ORCL
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Verify the Configuration of Oracle Management Server
To verify that the configuration was successful, start the Oracle Management Server.

Managing the Oracle Management Server on UNIX
On UNIX, Oracle Enterprise Manager uses the oemctrl command to start and
stop the Oracle Management Server. The relevant oemctrl  commands to control
the UNIX Oracle Management Server are listed in the following table. In all cases,
the command string is case-sensitive and must be entered with lowercase
characters.

Note: If you are unsure of your values for the <OMS connect
string>, run the Enterprise Manager Configuration Assistant and
select Edit Configuration Parameters to view your Enterprise
Manager repository credentials and settings.

Note: You can run this script multiple times without causing
problems.

If you want to... Enter the command...

Start Oracle
Management
Server

oemctrl start oms

NOTE: To start Oracle Management Server as a background process, type:

oemctrl start oms &

Stop Oracle
Management
Server

oemctrl stop oms <EMAdministratorName>/<EmPassword>

where

EMAdministratorName is your Oracle Enterprise Manager super administrator
name (for example,  "sysman").

EmPassword in your Oracle Enterprise Manager super administrator password
(for example, "oem_temp"). EmPassword is case-sensitive and must be entered
in the same case as it was originally entered.
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Managing the Oracle Management Server on Windows NT
On Windows NT, the Oracle Management Server runs as a Windows NT service.
The steps to control the Oracle Management Server are listed in the following table.

The status information of the Oracle Management Server includes the following:

■ Overall status of the Oracle Management Server

■ Time period the Oracle Management Server has been up and available

■ Statistics regarding the performance of the Oracle Management Server

Verify status of
Oracle
Management
Server

oemctrl status oms <EMAdministratorName>/<EmPassword>[@<hostname>]

where

EMAdministratorName is your Oracle Enterprise Manager super administrator
name (for example, "sysman").

EmPassword is your Oracle Enterprise Manager super administrator password
(for example, "oem_temp"). EmPassword is case-sensitive and must be entered
in the same case as it was originally created.

hostname is the machine where your Oracle Management Server is running. You
do not need to enter the host name if the Oracle Management Server is running
locally.

If you want to... Do the following...

Start Oracle Management
Server

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>ManagementServer=>Start

Stop Oracle Management
Server

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>ManagementServer=>Stop

NOTE: You must have the Windows NT operating system
administrator privilege to stop the Oracle Management Server.

Verify status of Oracle
Management Server

Start=>Settings=>Control Panel=>Services=>Oracle<name of
Oracle home>Management Server=>look at Status column

or

oemctrl status oms

If you want to... Enter the command...
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Running the Management Pack for Oracle Applications from a Web Browser
Windows NT clients can run the Oracle Enterprise Manager console from a web
browser without installing any software on the client node. In this mode of
operation, Concurrent Manager Server discovery and Advanced Events are
available. However, the other tools in the Management Pack for Oracle Applications
are not supported.

To run in this mode of operation, some special set up steps must be taken to make
the Enterprise Manager software available from a web server. Refer to the web
browser information in the Oracle Enterprise Manager Configuration Guide for a
complete description of how to set up and run Oracle Enterprise Manager in this
configuration.
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Client Node
After you install the client software for the Management Pack for Oracle
Applications, you must:

❏ Configure Net8 in the Enterprise Manager Oracle home

❏ Verify the connection to the Oracle Applications instance

❏ Verify the configuration of the client node

Configuring Net8 in the Enterprise Manager Oracle Home
Enterprise Manager software on the client node must be able to make a Net8
connection to the Oracle Applications instance database. One method of achieving
this connection is to have an entry for this database in the tnsnames.ora file in the
Enterprise Manager $ORACLE_HOME/network/admin directory. Refer to the
Net8 documentation for details.

Verifying Net8 in the Enterprise Manager Oracle Home
Verify that you can connect to the Oracle Applications instance from the Enterprise
Manager Oracle home. Type sqlplus <user>/<password>@<apps_dbname> ,
to confirm that the database instance can be reached. The <apps_dbname> you use
in this verification step must be the same fully qualified tns name you created in the
previous step described in Configuring Net8 in the Enterprise Manager Oracle
Home on page 2-18.

Verifying the Configuration of the Client Node
To verify that the configuration was successful, perform the following steps:

1. Start the Oracle Enterprise Manager console.

2. Discover nodes and servers to manage in the console.

3. Set preferred credentials.

4. Start the applications delivered with the Management Pack for Oracle
Applications.

Important: The tns alias you add to your client tnsnames.ora file
must be exactly the same as the fully qualified database name you
entered into the oapps.ora file.
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The following sections describe these tasks in detail.

Starting the Oracle Enterprise Manager Console
1. Start the Oracle Enterprise Manager console.

■ On Windows NT, start the console from the Windows Start menu under the
appropriate Oracle home.

■ On UNIX, start the console from the command line by typing:

oemapp console

The command string is case-sensitive and must be entered with lowercase
characters.

2. If you are logging in to the console for the first time, at the first login dialog,
type in the default credentials for the super administrator account.

Administrator = sysman

Password = oem_temp

3. From the Oracle Management Server pull-down list, select an Oracle
Management Server which is configured for Oracle Applications management.

If the name of the Oracle Management Server you want to use does not appear,
do the following:

a. Click the Management Servers button. The Management Servers dialog
appears.

b. Click the Add button. The Add Management Server dialog appears.

c. Type in the host name of the computer on which the Oracle Management
Server you want to add is running, and click OK.

d. Select the Oracle Management Server from the pull-down list.

4. After the initial login, a security login dialog appears where you can change
your password. Change the password immediately.

Note: Passwords must have no more than 8 characters.
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Discovering Nodes and Services
During the start up of the Oracle Management Server, the manageable services on
the machine where the Oracle Management Server is running are automatically
discovered. The Console Navigator shows all these discovered services.

To discover additional nodes:

1. Select Discover Nodes from the Console’s Navigator menu.

2. Enter the host name of the node in the text window of the Discover Nodes
dialog. You can discover multiple services at one time by entering each node
you want to discover on a new line within the text window.

3. Click OK to continue.

If a node cannot be discovered, it may be because the node is down or the node is
not running an Intelligent Agent. Also note that you must be using the TCP/IP
network protocol.

After discovering the node on which your concurrent manager service resides, you
should see a Concurrent Manager folder in the navigator tree of the Oracle
Enterprise Manager console. If you do not see this folder, verify that your
configuration of that node was successful and then rediscover that node from the
console.

Setting Preferred Credentials
You must enter preferred credentials for both the concurrent manager and the
managed node. The Intelligent Agent uses these credentials when running jobs on
the managed node.

To enter preferred credentials, select System=>Preferences=>Preferred Credentials
on the Oracle Enterprise Manager console main window. To manage Concurrent
Manager Servers, you must add preferred credentials for each concurrent manager
discovered, and you must add node credentials for the host computer on which
they run. Refer to "Default Display for the Navigator" on page 3-4 for the
information needed in each of the fields.

Note: Node credentials for Windows NT nodes must be for users
who are granted the Windows NT Log on as a batch job privilege.
See "Configuring Windows NT Security for the Enterprise Manager
Job System" on page 2-7 for details on configuring this privilege.
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Starting Applications in the Management Pack for Oracle Applications
After starting the Oracle Enterprise Manager console, you can now start the
applications in the Management Pack for Oracle Applications. The following table
lists these applications and where to find the appropriate information.

Step Where to Find the Information

Starting Oracle Performance
Manager

See "Starting Oracle Performance Manager" on page 3-3.

Starting Oracle Capacity
Planner

See "Introduction to Oracle Capacity Planner" on page 4-1.

Starting Concurrent Processing
Tuning Assistant

See "Concurrent Processing Tuning Assistant" on page 5-1.

Using Advanced Events See "Oracle Applications Advanced Events" on page 6-1.
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Configuration Checklist
The following table provides a checklist of steps to perform when configuring the
Management Pack for Oracle Applications.

Table 2–1 Configuration Checklist

Managed Node (Concurrent Manager Node)

❏ Apply Oracle Applications patch for bug #730116 or bug #901809

See "Applying Oracle Applications Patch for Bug #730116 or Bug #901809" on page 2-2.

❏ Install software on the managed node

The Management Pack for Oracle Applications requires an 8.0.6 or 8.1.5 Intelligent
Agent. You can install Agent extensions into an existing 8.1.5 or 8.0.6 Agent home or
you can install the 8.1.5 Agent from the Management Pack for Oracle Applications
media into a new Oracle home. Oracle strongly recommends running the Agent in a
separate Oracle home to facilitate future upgrades.

❏ Configure Net8

See "Configuring Net8 in the Intelligent Agent’s Oracle Home" on page 2-4.

❏ Verify Net8 configuration

See "Verifying Net8 Configuration in the Intelligent Agent’s Oracle Home" on page 2-5.

❏ Configure $ORACLE_HOME/network/agent/config/oapps.ora file

See "Configuring the oapps.ora File" on page 2-5 and information in the file itself.

❏ Configure Windows NT security

See "Configuring Windows NT Security for the Enterprise Manager Job System" on
page 2-7.

❏ Enable disk statistics collection (Windows NT only)

See "Enabling Disk Statistics Collection for Capacity Planner and Performance
Manager on Windows NT" on page 2-7.

❏ Start the Intelligent Agent and data gatherer in the newly installed Oracle Home

See "Verifying the Configuration of the Managed Node" on page 2-8 and information in
the file itself.

Oracle Management Server Node

❏ Install software

Skip this step if an Oracle Management Server release 2.0.4 is already running.
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❏ Create an Oracle Management Server repository

Skip this step if an Oracle Management Server release 2.0.4 is already running. The
installation will guide you through these steps. See "Creating the Oracle Management
Server Repository" on page 2-13 or refer to the Oracle Enterprise Manager
documentation for additional details.

❏ Register the Management Pack for Oracle Applications extensions

See "Registering the Management Pack for Oracle Applications Extensions" on
page 2-14.

❏ Verify the configuration of the Oracle Management Server

See "Verify the Configuration of Oracle Management Server" on page 2-15.

❏ (Optional) Run the Management Pack for Oracle Applications from a web browser

See "Running the Management Pack for Oracle Applications from a Web Browser" on
page 2-17.

Client Node (Oracle Enterprise Manager Console Node)

❏ Install software

❏ Configure Net8

See "Configuring Net8 in the Enterprise Manager Oracle Home" on page 2-18.

❏ Verify Net8 configuration

See "Verifying Net8 in the Enterprise Manager Oracle Home" on page 2-18.

❏ Start the Oracle Enterprise Manager Console

See "Starting the Oracle Enterprise Manager Console" on page 2-19.

❏ Discover managed node (Concurrent Manager Node)

See "Discovering Nodes and Services" on page 2-20.

❏ Set preferred credentials

See "Setting Preferred Credentials" on page 2-20.

❏ Start and use the Management Pack for Oracle Applications tools

See "Starting Applications in the Management Pack for Oracle Applications" on
page 2-21.

Table 2–1 Configuration Checklist (Cont.)
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3
Introduction to Oracle Performance

Manager

Oracle Performance Manager is an Oracle Enterprise Manager application that
allows you to monitor different types of performance data.

To collect performance data for Oracle Performance Manager, the Agent data
gathering service (Oracle Data Gatherer) must be installed. Install the Agent data
gathering service on the system (or systems) where you want to monitor data. Note
that when you are using Oracle Performance Manager to monitor concurrent
manager data, the Agent data gathering service can be installed on another system.
See the Oracle Enterprise Manager Configuration Guide for information on installing
the Agent data gathering service on a system. See the Oracle Management Pack for
Oracle Applications Installation for information on installing the Intelligent Agent
Extensions from the Management Pack for Oracle Applications CD-ROM.

The types of performance data that Oracle Performance Manager can monitor on a
system depends on the products that are installed. Table 3–1 shows the types of
data that Oracle Performance Manager can monitor when various Oracle products
are installed.

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products
Are Installed

Oracle
Product

Oracle
Concurrent
Manager Data

Oracle
Server
Data

Operating
System Data

SAP R/3
System
Data

Microsoft
SQL
Server
Data

Diagnostics
Pack

Yes Yes Yes
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If additional products from Oracle or other vendors are installed, Oracle
Performance Manager may be able to monitor additional types of data not shown in
Table 3–1.

Usage Scenarios for Oracle Performance Manager
Using Oracle Performance Manager, you can:

■ Monitor one or more services concurrently

■ View the monitored data in various chart formats, including strip (line), pie,
bar, table, and hierarchical

■ Set the refresh interval for a chart’s data

■ View multiple charts concurrently for each monitored service

■ View multiple charts in a single frame

■ Drill down from one chart to another

■ Choose the collected data and data sources of chart data to display

■ Print a chart

■ Generate a report for a chart

Management
Pack for
Oracle
Applications

Yes Yes

Management
Pack for SAP
R/3

Yes Yes

Standard
Management
Pack (Oracle
Standard
Edition only)

Yes Yes Yes

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products
Are Installed (Cont.)

Oracle
Product

Oracle
Concurrent
Manager Data

Oracle
Server
Data

Operating
System Data

SAP R/3
System
Data

Microsoft
SQL
Server
Data
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■ Display context-sensitive help for a chart, if the cartridge supplies the help

■ Play the recording of a chart, with fast-forward and pause features

Starting Oracle Performance Manager
Oracle Performance Manager can be started from the Oracle Enterprise Manager
console and from the Start menu.

Starting Oracle Performance Manager from the Console
You can start Oracle Performance Manager from the Oracle Enterprise Manager
console in any of the following ways:

■ On the Oracle Enterprise Manager console, point to the Application
Management drawer, then click Performance Manager.

■ On the Tools menu of the Oracle Enterprise Manager console, point to
Application Management, then click Performance Manager.

■ On the Oracle Enterprise Manager console, select a concurrent manager service,
right mouse click, then follow the path Related Tools=>Performance Manager.
This allows you to start Performance Manager and be connected to the service
you have selected.

Starting Oracle Performance Manager from the Start Menu
On the Start menu, follow the path: Start=>Programs=>ORACLE_
HOME=>Application Management=>Performance Manager. This displays the
Performance Manager Login dialog box.

Note: When you start Oracle Performance Manager from the
Oracle Enterprise Manager console, Oracle Performance Manager
connects to the Oracle Management Server using the same
credentials used to start the Oracle Enterprise Manager console.

Note: ORACLE_HOME represents the Oracle home in which the
Management Pack for Oracle Applications is installed.
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To run Oracle Performance Manager in repository mode, click Login to the Oracle
Management Server, enter the appropriate connection information for your Oracle
Management Server, then click OK. The specified Oracle Management Server and
its associated repository must already exist. You can access the Management Servers
dialog box from the Oracle Enterprise Manager console login dialog box to manage
your list of recognized Oracle Management Servers.

To run Oracle Performance Manager in standalone mode (not connected to the
Oracle Enterprise Manager repository), click Standalone, no repository connection,
then click OK.

Using the Oracle Performance Manager Main Window
The primary component of the Oracle Performance Manager user interface is the
main window, which contains two views.

The navigator or tree view appears on the left side of the main window. The
navigator displays the items that are pertinent to Oracle Performance Manager,
primarily services, cartridges, classes, charts, and recordings of charts.

When you select an item in the navigator, the right side of the main window
displays the property sheet for the selected item.

Default Display for the Navigator
By default, the Oracle Performance Manager navigator displays the services you
discovered using the Oracle Enterprise Manager console. See Figure 3–1 for an
example.

Note: If the repository information for the Management Pack for
Oracle Applications has not been created, Oracle Performance
Manager automatically updates the repository at connection time.
Similarly, if your repository version differs from the version of
Oracle Performance Manager and Oracle Enterprise Manager, the
repository will be upgraded automatically.

Also, you can run Oracle Performance Manager without being
connected to a valid repository. However, any recordings you make
during the session will not be saved when you exit Oracle
Performance Manager.
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Figure 3–1 Navigator

The Network folder contains a folder for each service type. For example, when you
have the Management Pack for Oracle Applications installed, the service types are
Nodes and Concurrent Managers. When these service type folders are expanded,
the folder will expand to show the corresponding services previously discovered
through the Oracle Enterprise Manager console. To connect to a service, expand its
corresponding node in the tree. You may be prompted for credentials if they are
required to connect to that service. In addition, the Recordings folder contains any
recordings of chart data that exist.

When you manually add a concurrent manager to the Oracle Performance Manager
navigator (by selecting the Concurrent Manager folder and clicking Add New
Service on the toolbar), the APPS Logon dialog box prompts you for the following
credentials:

■ APPS Schema Name

The name of the Applications schema (or database user name) you are
connecting to; the name of the database account used by this instance of Oracle
Applications.
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■ APPS Schema Password

The database password for logging into this schema.

■ Gateway User ID

The value of the GWYUID applications environment variable including the
password, for example, applsyspub/pub. An optional field for this release.

■ Application Username

Oracle Applications user name. An optional field for this release.

■ Application Password

Oracle Applications password. An optional field for this release.

■ APPS Database Name

The name of the database which this instance of Oracle Applications is using.
The Data Gatherer uses this value as a TNS alias to connect to the Applications
database, so it must be present in the tnsnames.ora file (or other TNS address
resolution mechanism) being used by the Data Gatherer.

■ Data Gatherer Location

Enter the name of the host where an Agent data gathering service is located.
This Agent data gathering service will be used to connect to and collect data
from the specified database. The default value for this field is the host where the
database is located.

Menu Options for the Navigator
The menu options for the navigator are as follows:

■ File

– Connect to Service

If a service node is selected, you are connected to the service.

– Disconnect from Service

If a service node is selected, Oracle Performance Manager closes all charts
for that service and disconnects from the service.

– Add New Service

When a service container is highlighted in the navigator, Oracle
Performance Manager displays the appropriate dialog box for that service.
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– Exit

Exits the Oracle Performance Manager application.

■ Recordings

– Stop Recording

Allows you to stop recording data. This menu item is enabled when a
recording is selected on the Recordings property sheet for a specific chart,
and a data recording session is currently in progress for that chart.

– Play Recording

Allows you to play previously recorded data. This menu item is enabled
when a completed recording is selected on the Recordings property sheet
for a specific chart.

– Remove Recording

Allows you to delete a recording. If you are connected to the repository, the
recording will also be deleted from the repository when you exit Oracle
Performance Manager.

If you are not connected to the repository, the recording will not be saved
when you exit Oracle Performance Manager. This menu item is enabled
when a completed recording is selected on the Recordings property sheet
for a specific chart.

– Stop All Recordings

Allows you to stop all active recordings. This menu item is enabled only if
active recordings exist.

■ Charts

– Show Chart

Displays the chart highlighted in the navigator tree.

– Add User-Defined Chart

Displays the New Chart property sheet. The Script page and the Data Items
page are displayed as part of the New Chart property sheet.

This option is not available for the Management Pack for Oracle
Applications.

– Remove User-Defined Chart



Using the Oracle Performance Manager Main Window

3-8 Getting Started with the Oracle Management Pack for Oracle Applications

Allows you to delete a user-defined chart from the repository. This menu
item is enabled when a user-defined chart is highlighted in the navigator
tree.

This option is not available for the Management Pack for Oracle
Applications.

– Create Like User-Defined Chart

Displays the Create Like User-Defined Chart dialog box. This menu item is
enabled when a user-defined chart is highlighted in the navigator tree.

This option is not available for the Management Pack for Oracle
Applications.

■ Help

– Using Help

Displays the Using Help topic of the Oracle Performance Manager help file.

– Contents

Displays the Contents page of the Oracle Performance Manager help file.

– Search

Displays the Search page of the Oracle Performance Manager help file.

– Window

When you select a panel, window, dialog box, or property page, this menu
option displays the help topic for the respective panel, window, dialog box,
or property page.

– Selected Item

When you select a class, chart, or data item in a panel or property page, this
menu option displays the help topic for the respective class, chart, or data
item.

– About Oracle Performance Manager

Provides version and copyright information about Oracle Performance
Manager.

Toolbar Icons for the Navigator
On the toolbar, you will find the following buttons:
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■ Connect to Service

■ Disconnect from Service

■ Add New Service

■ Add User-Defined Chart

This option is not available for the Management Pack for Oracle Applications.

■ Remove User-Defined Chart

This option is not available for the Management Pack for Oracle Applications.

■ Show Chart

■ ? (displays the Contents page of Oracle Performance Manager help)

To display a chart, select the chart in the navigator, and click Show Chart on the
toolbar.

Working with Charts
You can start a chart using one of the following methods:

■ Select the chart in the navigator, and clicking Show Chart on the toolbar.

■ Select the chart in the navigator, choose Charts=>Show Chart.

■ Select the chart in the navigator, which displays the chart’s property sheet. To
start the chart with the selected property sheet options, click Show Chart on the
property sheet.

■ Select a statistics class node, then select the chart on the right and click Show
Chart.

■ Select a chart in the navigator tree, choose Charts=>Show Chart.

Each chart or chart group is displayed in its own window, which is separate from
the main window. Each chart or chart group window has a toolbar to provide you
with control over the attributes of the chart or chart group. In the chart group
window, the toolbar applies to the active chart (the chart that has focus).

You can specify the collection interval for the chart data, which controls how often
Oracle Performance Manager updates the data in the chart display.
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Selecting Collected Data and Data Sources
For some charts, the chart’s property sheet may allow you to select the collected
data to display and the data sources for which the collected data should be
displayed. The collected data are the statistics that can be monitored and displayed
in the chart. The data sources are the items from which Oracle Performance
Manager is able to collect the data. For example, the data source of disk statistics
may be disk1 or disk2, and the data source of file statistics may be file1 or file2.

By clicking in the column next to the name of the collected data or the name of the
data source in the chart property sheet, you can specify whether or not to monitor
that collected data or data source and display it in the chart. When a green check
mark appears in the column, Oracle Performance Manager will display that
collected data or data source in the chart. If you click in the column again, the check
mark goes away, which indicates that Oracle Performance Manager will not display
that collected data or data source. You can toggle back and forth between
monitoring and not monitoring collected data or a data source by clicking in the
column. If the check mark is gray, it means Oracle Performance Manager will
display the collected data or data source, and you are unable to change the selection
of this data.

If the chart definition contains default data source or collected data attributes, then
those items are preselected in the chart’s property sheet.

Monitoring Multiple Services Concurrently
You can view charts from multiple services concurrently by connecting to the
services from the navigator tree and starting the chart.

Viewing Multiple Charts Concurrently for a Service
Some types of data include a chart group, which is two or more charts that are
displayed concurrently. You start a chart group the same way as you start a chart.

Charts in a chart group are displayed within a single window.

Selecting a Chart Format
A toolbar is displayed in every chart window. Click the button in the toolbar
representing the chart format in which the chart’s data should be displayed. The
available chart formats are:

■ Pie
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■ Bar

■ Strip (or line chart)

■ Table

■ Hierarchical

Selecting Chart Options
Oracle Performance Manager allows you to select filters to limit the data collected
for a chart. Not all filters are available for all charts.

You can select a limit to the number of data sources that are displayed. For example,
if the data sources are the processes on an operating system, you can query the
chart to display only 10 processes, rather than all the processes. To select a limit to
the number of data sources that are displayed, do the following:

1. Highlight the Process Default Chart in the navigator tree by traversing the tree
as follows: Network=>Nodes=><Name of Node>=>Process=>Process Default
Chart.

2. Show the Process Default Chart.

3. In the display window for the Process Default Chart, click the Set Options
button located in the toolbar.

4. In the Options tab, set the Maximum Number of Data Sources to Display to 10.

5. Click OK.

Also, you can query the Agent data gathering service to sort the data based on a
piece of data being collected.

These options can be useful for finding the top resource users. In the case where
processes are the data sources and the data collected is memory usage and CPU
usage, you can ask the Agent data gathering service to limit the number of data
sources to 10, and to sort by memory usage. Your chart would then show the 10
processes using the most memory. If you were to sort by CPU usage, you would get
the 10 processes using the most CPU instead.

Some charts can also give different views of the data. If that feature is available, you
will also be able to select a view of the data. An example of a data view may be the
current rate per second or current rate per transaction for each piece of data
collected in the chart.
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Chart-Specific Commands
Some charts have commands associated with them that can be run by the target
service. An example of this is the Kill Session command that is available in the Lock
Manager charts for Oracle database services. If a chart-specific command is
available for a chart, it will appear in the popup menu displayed by clicking the
right mouse button while the cursor is positioned over a data item in a chart
display.

Drilling Down from One Chart to Another
Some charts have other drill-down charts associated with them. To display a
drill-down chart, use the right mouse button to click an item name in the chart
legend, the chart title, or a data item in a chart. A list of drill-down charts associated
with that chart item is displayed. If a list of drill-down chart names is not displayed
when you click the right mouse on a legend item, it means no drill-down charts are
associated with that item.

Displaying Alternate Chart Types
When you are displaying monitored data in a chart, you can change the type of
chart. For example, if data is being displayed in a bar chart, you can choose to
display it in a pie chart.

To change the type of chart, in the toolbar click the button associated with the type
of chart you want.

Displaying Alternate Chart Orientations
You can display bar charts with either a horizontal or vertical orientation.

To change the orientation of the bar chart, in the toolbar click the button associated
with the orientation that you want.

Sorting Data in a Table Chart
When a chart is displaying data in table format, the sort order of the column data
can be changed by clicking the column headers in the table. The first click on a

Note: It is recommended that you pause a chart before drilling
down on a record. This assures that the particular data point does
not disappear during the drill-down.
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column header sorts the data in ascending order, and a second click sorts the data in
descending order. Changing the sort order in the chart table does not affect the
data’s sort order on the server. To change the sort order of the data on the server,
use the Options page.

Obtaining Help for a Chart
From the chart or class Detail property sheet in the Oracle Performance Manager
main window, let the mouse pause over the chart or data item name and help will
display at the point of the cursor. Also, if a chart or data item is selected, the
Help=>Selected Item menu item will display help for that object in a separate
browser frame.

Printing a Chart
To print a chart, click the Print Chart button while the chart is displayed.

The size of the chart on the screen determines the size of the chart in the chart
printout. For example, when you print a chart that is 5 inches high and 7 inches
wide on your screen, the chart will be 5 inches high and 7 inches wide in the
printout.

Generating a Report for a Chart
To generate a report for a chart, click the Report Chart button while the chart is
displayed. This displays the Save HTML Chart Report dialog box, which allows you
to save a chart report in HTML format. After you specify the name of the chart
report file, Performance Manager allows you to preview the report by displaying it
on your screen.

Note that regardless of the file type you specify for the report, the report is saved in
HTML format. You can view the report again later using a web browser.

Recording Chart Data
Oracle Performance Manager allows you to record the data being monitored in a
chart. After a recording is complete, you can play it back. During playback, you can
pause and fast forward the recording, if you wish.

Note: Help is not available for all objects.
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A chart recording can be located either under the Recordings folder or the Network
folder. You can manage chart recordings in the Recordings tree without connecting
to the service from which a chart was recorded. If you are already connected to a
service under the Network tree, you can see a chart’s recordings by selecting the
Recordings tab in that chart’s Detail property sheet.

Starting a Recording
You start a recording by performing one of the following steps:

■ With a chart highlighted in the navigator tree, click Record Chart on the chart’s
Data property sheet.

■ With a chart displayed in the Chart Display window, click Start Recording in
the toolbar.

■ With a chart displayed in the Chart Display window, click Start Recording from
the Recording menu.

Oracle Performance Manager displays the Recording Parameters dialog box, which
allows you to enter:

■ Recording name

The name of the recording. The default name of the recording is the chart name.
This name does not need to be unique.

■ Recording directory

The directory where the recording is stored. The directory default is c:\temp.

■ Recording interval

How often information is sent back from the server to the recording.

Stopping a Recording
Before you can play a recording, you must stop the recording. To stop a recording,
do the following:

1. Navigate to the Recordings folder or the Recordings tab in the chart’s Detail
page.

2. Select the chart being recorded.

3. In the corresponding property sheet, select the recording and click Stop
Recording or click Stop Recording from the Recordings menu.
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You can now play the recording.

You can stop all recordings at one time. On the Recordings menu, click Stop All
Recordings.

You can also stop one recording from the Chart Display window by clicking End
Recording from the toolbar or End Recording from the Recording menu.

Accessing a Recording for Playback
You can play completed recordings.

To play a recording, do the following:

1. Navigate to the Recordings folder.

2. Select the chart you want to play in the navigator tree.

3. In the corresponding property sheet, select the chart and click Play Recording
(or on the Recordings menu click Play Recording).

4. In the Chart Display window, click Start Playback.

The Stop Playback, Pause Playback, Fast Forward, and Reset Playback buttons
become available in the playback window.

Removing a Recording
To remove a recording:

1. Navigate to the Recordings folder or the Recordings tab on the chart’s Detail
page.

2. Select the recording you want to remove.

3. From the Recordings menu, click Remove Recording.
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4
Introduction to Oracle Capacity Planner

Oracle Capacity Planner is an Oracle Enterprise Manager application that allows
you to collect different types of performance statistics and record that data in a
historical database.  You can then use Oracle Capacity Planner to analyze the
historical data to plan future capacity.

To collect performance data for Oracle Capacity Planner, the Agent data gathering
service (Oracle Data Gatherer) must be installed. Install the Agent data gathering
service on the system (or systems) where you want to collect data. Note that when
you are using Oracle Capacity Planner to collect database data, the Agent data
gathering service can be installed on another system. See the Oracle Enterprise
Manager Configuration Guide for information on installing the Agent data gathering
service on a system.

The types of performance data that Oracle Capacity Planner can collect on a system
depends on the products that are installed. Table 4–1 shows the types of data that
Oracle Capacity Planner can collect when various Oracle products are installed.

Table 4–1 Data That Capacity Planner Can Collect When Various Oracle Products are
Installed

Oracle
Product

Oracle
Concurrent
Manager
data

Oracle
Database
data

Node
(operating
system)
data

SAP R/3
system
data

Microsoft
SQL
Server
data

Diagnostics
Pack

Yes Yes Yes

Management
Pack for
Oracle
Applications

Yes Yes
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If additional products from Oracle or other vendors are installed, Oracle Capacity
Planner may be able to collect additional types of data not shown in Table 4–1.

Data is collected at a specified interval and stored in an efficient binary form. At a
specified loader interval, the data is read from this binary file and stored in a
readable form in the Oracle Capacity Planner historical database.  The Agent data
gathering service also aggregates the data by time, creating summary statistics for
the data that is collected at different time intervals (hour, day, week, and so on).
Finally, the Agent data gathering service performs a purge of the data in the
historical database, keeping only as much data as you specify.  This allows you to
have access to a current view of recent performance data for your environment and
to manage the amount of stored data to avoid wasting disk space.

Usage Scenarios for Oracle Capacity Planner
Oracle Capacity Planner can perform tasks such as the following:

■ Track the increase in the amount of used space on a disk over time and estimate
when 95 percent of the space on the disk will be consumed

■ Track the increase in the total I/O rate for a host over time, then estimate what
the total I/O rate for the host will be at some future point in time

Starting Oracle Capacity Planner
You can start Oracle Capacity Planner in any of the following ways:

■ On the Oracle Enterprise Manager console, click the Application Management
drawer, then click Capacity Planner.

■ On the Oracle Enterprise Manager console, select a   Concurrent Manager or
Node service, click the right mouse button, point at Related Tools in the menu,
then click Capacity Planner.

Management
Pack for SAP
R/3

Yes Yes

Table 4–1 Data That Capacity Planner Can Collect When Various Oracle Products are
Installed

Oracle
Product

Oracle
Concurrent
Manager
data

Oracle
Database
data

Node
(operating
system)
data

SAP R/3
system
data

Microsoft
SQL
Server
data
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■ On the Tools menu of the Oracle Enterprise Manager console, point to
Application Management, then click Oracle Capacity Planner.

■ From the Start menu, point to Programs, then to the Oracle Home where Oracle
Enterprise Manager is installed, then to Application Management, then click
Capacity Planner, which displays the Capacity Planner Login dialog box.

To run Oracle Capacity Planner in repository mode, click the Login to the
Oracle Management Server option, enter the appropriate connect information
for your Oracle Enterprise Manager repository, then click OK.

To run Oracle Capacity Planner in standalone mode (not connected to the
Oracle Enterprise Manager repository), click the Standalone, no repository
connection option, then click OK.

Using Help
When you are using Oracle Capacity Planner, you can display context-sensitive help
topics. You can also display conceptual topics and task topics.

To obtain context-sensitive help for an Oracle Capacity Planner panel, window,
dialog box, or property page, select an item in the panel, window, dialog box, or
property page (not the tab for a property page), then on the Help menu, choose
Window.

To obtain context-sensitive help for a class, chart, or data item on a property page,
select the class, chart, or data item on the property page, then take one of the
following actions:

■ Press F1.

■ Click the Help icon on the toolbar.

■ On the Help menu, choose Selected Item.

Note: This manual describes the features of Oracle Capacity
Planner when Oracle Capacity Planner is running in repository
mode.  Some Oracle Capacity Planner features, such as
automatically displaying the services known to the Oracle
Enterprise Manager console, are only available when Oracle
Capacity Planner is running in repository mode. For more
information about running Oracle Capacity Planner in repository
mode and standalone mode, see the online help for Oracle Capacity
Planner.
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If a help topic is not available for a class, chart, or data item, a No Help Available
message is displayed when you request help.

To view the Contents page for the Oracle Capacity Planner help, on the Help menu,
choose Contents. On the Contents page, you can:

■ View a list of the conceptual help topics by double-clicking the Conceptual
Topics book on the help system’s Contents page.

Conceptual topics provide conceptual or overview information that you should
be aware of before performing a particular Oracle Capacity Planner task.
Conceptual topics do not contain step-by-step information for performing a
task.

■ View a list of the task help topics by double-clicking the Task Topics book on
the help system’s Contents page.

Task topics provide step-by-step instructions for accomplishing an Oracle
Capacity Planner task. They do not provide conceptual information that you
should be aware of before performing the task.

You can access a glossary of Oracle Capacity Planner terms by double-clicking the
Oracle Capacity Planner Glossary book on the Contents page.

Using Oracle Capacity Planner
You may find it helpful to think of using Oracle Capacity Planner as a two step
process:

1. Setting up the collection of historical data

See "Setting Up a Collection" on page 4-4 for a detailed description of how to
collect historical data.

2. Analyzing the collected data

See "Analyzing Collected Data" on page 4-13 for a detailed description of how
to analyze collected data.

Setting Up a Collection
To set up a historical data collection with Oracle Capacity Planner, you:

1. Select the services for which you want to collect historical data.

2. Define the frequency of collection samples.
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3. Define the frequency at which collected data should be loaded in the Oracle
Capacity Planner database.

4. Define the amount of data to be kept in the Oracle Capacity Planner database at
each time interval.

5. Select the classes of data to collect, based on what is available in the Oracle
Capacity Planner navigator.

Figure 4–1 shows the steps to follow when setting up a collection.  For more
information on each step, see the following sections.

Figure 4–1 Steps for Setting Up a Collection

Selecting Services
You can select one or more services from which you want to collect historical
performance statistics. For example, when you have the Management Pack for
Oracle Applications installed, the service types are Nodes and Concurrent
Managers. Before you select a service from which to collect data, click the
Collection tab of the Oracle Capacity Planner navigator panel, which displays the
Oracle Capacity Planner collection view.

The Oracle Capacity Planner navigator tree view displays the services that are
known to the Oracle Enterprise Manager main console.  When you select a service
in the Oracle Capacity Planner navigator panel, you may be prompted for
credentials if they are required to connect to that service. After you connect to a

Define the collection frequency

Define the frequency of loading class data

Define the amount of data to keep 
for a time interval

Select a service to collect data from

Specify the classes to collect

NU-3695A-AI
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service, the available collection classes for that service are displayed in the
navigator.

When you manually add a Concurrent Manager to the Oracle Capacity Planner
navigator (by selecting the Concurrent Manager folder and clicking Add New
Service on the toolbar), the APPS Logon dialog box prompts you for the following
credentials:

■ APPS Schema Name

The name of the Applications schema (or database user name) you are
connecting to; the name of the database account used by this instance of Oracle
Applications.

■ APPS Schema Password

The database password for logging into this schema.

■ Gateway User ID

The value of the GWYUID applications environment variable. An optional field
for this release.

■ Application Username

Oracle Applications user name. An optional field for this release.

■ Application Password

Oracle Applications password. An optional field for this release.

■ APPS Database Name

The name of the database which this instance of Oracle Applications is using.
The Agent data gatherering service (Oracle Data Gatherer) uses this value as a
TNS alias to connect to the Apps database, so it must be present in the
tnsnames.ora file (or other TNS address resolution mechanism) being used by
the Oracle Data Gatherer.

■ Data Gatherer Location

Enter the name of the host where an Oracle Data Gatherer is located. The Oracle
Data Gatherer will be used to connect to and collect data from the specified
database. The default value for this field is the host where the database is
located.

When you select a service, Oracle Capacity Planner displays the Service property
sheet for that service, which contains the following property pages:

■ Collection Options page
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■ Storage Options page

■ Purge Options page

The collection, load, and purge settings that you select on these pages apply to each
class of data collected from the service.

Defining the Frequency of Collection Samples
When you select a service, the Collection Options property page is displayed.  The
values you select on the Collection Options property page determine the frequency
of collection samples for the service.  On the Collection Options property page, you
can set the frequency of collection samples using either of these two methods:

■ By selecting the number of data samples to collect for a specified time interval

■ By specifying the length of time between collection samples

Defining the Frequency of Loading Collection Data
When you select a service, you can click the Storage Options tab to display the
Storage Options property page.  On the Storage Options property page, you specify
the options for the location and update frequency of the Oracle Capacity Planner
historical database, as follows:

1. Specify the Oracle Capacity Planner historical database that will store the
collection data for the service.

Enter the appropriate username, password, and service for the Oracle Capacity
Planner historical database.  This connection information is used by the Agent
data gathering service when it loads the collected data at the specified loader
interval.  Therefore, the service specified for the Oracle Capacity Planner
historical database must be known and accessible from the host where the
Agent data gathering service is running.  For example, if you specify MY_
DB.WORLD as the historical database and your Agent data gathering service is
running on host MYNODE, then database MY_DB.WORLD must be reachable
via Net8/SQL*Net from host MYNODE (MY_DB.WORLD must exist in the
TNSNAMES.ORA file for host MYNODE, for example).

Note: To configure the settings for collecting data, the Agent data
gathering service that will collect data for a service must be
running.  Normally, the Agent data gathering service is located on
the host where the service is located.
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2. Specify values that determine how frequently the Oracle Capacity Planner
loader program loads collection data for the service.

You can set the frequency of data collection loads using either of these two
methods:

– By using the Per Time Interval field to specify the number of loader passes
for a specified time interval

– By using the Time Between field to specify the length of time between
loader passes

3. Specify the next loader pass time.

To set a time for the next loader pass, specify that time in the Next Transfer
Occurs at field. To do this, click on the value that you want to change in the
date and time box, then click the up or down arrow to select a higher or lower
value.  If the current time is later than the time displayed for the Next Transfer
Occurs at setting, click Refresh View to update the display to show the actual
time of the next loader pass.

Note that the values that you select on the Storage Options property page apply to
all the classes of data collected on the selected service.

Understanding When the Loader Runs
The loader runs at the regular time interval specified on the Storage Options
property page.  The time specified in the Next Transfer Occurs at field controls
when the loader runs.  For example, if you want the loader to run once a day at 2:00
a.m., then set the transfer interval to once per day, and set the next transfer time to
the next day at 2:00 a.m.  The loader will run for the first time at 2:00 a.m. the next
day, and then will run once a day, each day at 2:00 a.m.

Understanding How Data Aggregation Works
Aggregation occurs only when the Oracle Capacity Planner loader runs.  During
aggregation, Oracle Capacity Planner examines the collection samples for a given

Note: Although data can be collected at short time intervals (such
as 5, 10, or 15 minutes), collected data is not available to you for
analysis until it has been loaded into the Oracle Capacity Planner
historical database. Therefore, the load interval you specify controls
when the most recently collected data will be visible to you.
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time interval, calculates an average value for that interval, then uses that average
value for calculations at the next larger time interval.  During a loader pass, Oracle
Capacity Planner examines the time stamps of all the collected data to determine
whether or not the threshold for a set interval (hour, day, week, month, or year) has
been crossed since the previous loader pass.  If so, Oracle Capacity Planner
performs an aggregation of collected data from the next smaller interval to the
interval threshold just passed. Table 4–2 shows the larger time interval to which
data at each time interval is aggregated.

An example may help clarify how Oracle Capacity Planner aggregates collection
data. Suppose Oracle Capacity Planner is collecting a data sample every 10 minutes
to capture the percentage of used space on a particular disk, and the loader runs
once an hour.   When the Oracle Capacity Planner loader runs and transfers data
into the Oracle Capacity Planner database every hour, it examines the values for the
percentage of used disk space in the samples collected during the previous hour,
then it computes an average percentage for the samples. That average percentage is
then used as the average value for the hour.  At the first loader pass after midnight,
Oracle Capacity Planner uses the hourly averages since midnight the previous day
to compute the day’s percentage of used disk space.  At the first loader pass after
midnight on Saturday, Oracle Capacity Planner examines the daily averages of used
disk space since midnight the previous Saturday and computes an average
percentage for the week.  At the first loader pass after midnight on the last calendar
day of the month, Oracle Capacity Planner examines the weekly averages since
midnight on the last calendar day of the previous month and computes an average
percentage for the month.  Finally, at the first loader pass after midnight on
December 31, Oracle Capacity Planner examines the last 12 monthly averages to
compute a yearly average.

Note that data is automatically aggregated by Oracle Capacity Planner.  After you
specify a collection frequency and a load frequency, Oracle Capacity Planner
aggregates the data at set intervals without requiring further input from you.

Table 4–2 Aggregation of Data from Smaller to Larger Time Intervals

Data at This Interval Aggregates to This Interval

Minutes Hours

Hours Days

Days Weeks

Weeks Months

Months Years
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The collection frequency that you set determines the lowest time interval for which
Oracle Capacity Planner can analyze data. Therefore, for example, if you want to be
able to analyze data from hourly intervals, you need to set a collection frequency of
at least once an hour.

Defining the Amount of Data to Keep
When you select a service, you can click the Purge Options tab to display the Purge
Options property page. On the Purge Options page, you specify the amount of data
you want to store in the Oracle Capacity Planner historical database for each type of
data (for example, hour data, day data, and week data).  You can accept the default
Purge Options property page values or choose different values.

The values set on the Purge Options property page apply to all the classes of data
collected on the selected service.

The values that you specify in the data retention table (the Enter the amount of data
that you want to keep table on the Purge Options page) determine how far back in
time you can go to analyze data for the different types of data.

Suppose, for example, you always want to be able to view hour data for the
previous six weeks.  In this case, for the Hours Data Type row in the data retention
table, you would enter 6 in the Timespan column and Weeks in the To Keep
column. This tells Oracle Capacity Planner that you want to keep hour data for a
6-week period. Oracle Capacity Planner calculates 6 weeks from the current time,
and the Purge Data Older Than column shows the time span for which hour data is
available. Table 4–3 shows the Hours row in the data retention table with this data
entered.

For each row in the data retention table, you can choose the time span to keep data
samples for that type of data by entering the desired value in the Timespan to Keep
column.

Applying and Reverting the Collection Settings for a Service
When you finish setting all the options on the Service property sheet, click Apply to
send those settings to the Agent data gathering service for the selected target
(service).  Note that you cannot select data to be collected until these settings have

Table 4–3 Specifying How Much Data to Keep for a Data Type

Data Type Timespan To Keep Purge Data Older Than

Hours 6 Weeks (current date minus 6 weeks)



Setting Up a Collection

Introduction to Oracle Capacity Planner 4-11

been applied.  At any time during the process of modifying the settings on the
Service property sheet, you may revert the settings to their last saved (applied)
state.  Once you have applied the settings, they cannot be reverted to their previous
setting using the Revert button; they must be modified manually.

Selecting the Classes of Data to Collect
After you set the collect and load options for a service, you can then select the
classes of performance data that you want to collect for that service.  You do this by
expanding the service in the Oracle Capacity Planner navigator (tree view).

Oracle Capacity Planner data is organized in the following hierarchy:

■ Classes

A class is a container for a particular category of data. Some types of data may
be organized into multiple classes. For example, operating system data might
include the following classes:

– Operating System Statistics

– Operating System Disk Statistics

– Operating System CPU Statistics

When you select a service in the navigator, the names of the classes are
displayed below the service in the tree view.

You can collect data from none, some, or all of the displayed classes for a
service.  A class may also be a container for other classes, to provide logical
groupings of the performance data at higher levels.  For example, an I/O class
may be a container for other more specific I/O classes.

■ Data items

In a class, each of the related statistics is referred to as a data item. For example,
an Operating System Disk Statistics class might include the following data
items:

– disk_name

– total_space

– used_space

– queue_length

– disk_util
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– system

A class can contain one or more data items.  When you select a class in the
navigator, the names of the data items and data sources associated with the data
items are displayed on the Collection Details property page.  Select the data
items that you are interested in collecting.  A green check mark appears next to
the name of each data item that is selected for collection.

A class can contain one or more data sources from which the class data items
can be collected.

■ Data sources

A data source is a description of where Oracle Capacity Planner can collect the
data items for a class.  A class can contain one or more data sources.  When you
select a class in the navigator, the names of the data items and data sources
associated with the class are displayed on the Collection Details property page.

The type of data in the class determines the data sources for the class.  For
example, in an Operating System Disk Statistics class, the data sources are the
individual disks for the operating system (for example, disk1, disk2, and so on).
In a CPU Utilization class, the sources are the individual CPUs for the host (for
example, cpu1, cpu2, and so on).

You can collect data items from one or more data sources.  When you select a
data source, a green check mark appears next to the name of the data source on
the Collection Details property page.

Starting Data Collection
After you select the data items that you want to collect from the available data
sources on the Collection Details property page, click Apply to confirm your
selections or click Revert to cancel the selections.

When you click Apply for a class of data, the icon for the selected class is marked
with a green dot in the Collection view of the navigator panel.  This green dot
indicates that one or more data sources is selected for collection for the class.

You can toggle the state of all data sources between collected and not collected by
clicking the Data Sources column header that contains the check mark.

Stopping Data Collection
To stop collecting data for one or more data items or data sources for a collection
class, follow these steps:

1. Select the collection class in the navigator.
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2. On the Collection Details page, click on the green check marks for those data
items or data sources from which you no longer want data collected, which
causes the check marks to disappear.

3. Click Apply.

To stop collecting data for all of the data items and data sources for a collection
class, follow these steps:

1. Select the collection class in the navigator.

2. On the Collection Details page, click Stop Collection.

3. Click Apply.

When no data sources are selected for collection for a class of data, the icon for that
class in the navigator does not display a green dot.

Troubleshooting Collection and Load Problems
During the collection and load processes, errors may be encountered by the Agent
data gathering service.  You can determine if data is not being collected or loaded
by using either of these methods:

■ Browsing the analysis data in the Oracle Capacity Planner navigator.  See
"Browsing Collected Data" on page 4-15 for more information on browsing
analysis data.

■ Accessing the historical database using SQL.  See "Understanding the Oracle
Capacity Planner Historical Database" on page 4-27 for more information on
accessing the historical database using SQL.

If data is not being collected or loaded, you should check the status of the Agent
data gathering service on the host from which data is being collected.  If the Agent
data gathering service is running, check the log file ($ORACLE_
HOME\odg\log\alert_dg.log) for errors related to the collection or loading of data.
See Oracle Enterprise Manager Configuration Guide for additional details on the
configuration of the Agent data gathering service.

Analyzing Collected Data
After collected data is loaded into the Oracle Capacity Planner historical database,
you can perform a variety of analyses on it. To access the analysis features of Oracle
Capacity Planner, select the Analysis tab in the Oracle Capacity Planner navigator
tree view.  This displays the Oracle Capacity Planner analysis view.
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Connecting to an Oracle Capacity Planner Historical Database
When you expand the Capacity Planning folder at the top of the navigator tree
view, you are prompted for the logon credentials for an Oracle Capacity Planner
historical database. After you connect to a historical database, the folder expands to
show the services for which data is available in that historical database.

If you store data in multiple historical databases, you must disconnect from one
historical database before you can connect to a different historical database.  To
disconnect from the current historical database, click the Capacity Planning folder
at the top of the navigator tree view, then on the File menu, choose Disconnect.
Then, to connect to a different historical database, expand the Capacity Planning
folder, and specify the logon credentials for the other historical database.

Organization of Data in the Navigator
When you expand a service in the navigator under the Capacity Planning folder,
two forms of data are displayed below the service:

■ Classes of data

The classes displayed for the service are the collection classes for which data is
available in the Oracle Capacity Planner historical database.  You can select and
view data from these classes by selecting a class in the navigator, specifying the
selection criteria, and then clicking Show New Chart.  These operations are the
first step in creating an analysis.

■ Analyses

Below each service in the navigator is an Analyses folder, which contains
predefined and user-defined analyses.  Predefined analyses are provided for
some Oracle products. You can create user-defined analyses by using an
existing analysis as a template or by selecting collected data from the available
classes of data for the service.

In the navigator, the bar chart icon is used for predefined analyses, and the bar
chart and person icon is used for user-defined analyses.

Creating a New Analysis
You can create a new analysis by:

■ Browsing collected data

■ Modifying an existing analysis
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■ Creating a copy of an existing analysis

Browsing Collected Data
When the navigator is displaying analysis view, the data collected for a particular
service is presented in the navigator as a list of collection classes. You can browse or
view this data by selecting a class of data that is of interest to you. This displays the
property sheet for the collection class.  By setting the selection criteria for this class
of data (see "Specifying Selection Criteria" on page 4-16) and clicking Show New
Chart, you create a new analysis that contains a view of the selected data.

Optionally, you can also add the data selection to an existing analysis.  See
"Working with Analyses" on page 4-20 for more information.

To create a new analysis, follow these steps:

1. Click the Analysis tab in the Oracle Capacity Planner navigator panel to display
the navigator panel’s analysis view.

2. Expand the Capacity Planning folder.  You are prompted for connection
information for the historical database that contains the collected data that you
want to analyze.

3. On the navigator panel, expand the folder for the service whose collected data
you want to analyze.  The navigator displays the:

■ Names of the classes for which collected data exists in the historical
database for the service

■ Analyses folder, which contains predefined and user-defined analyses for
the service

4. On the navigator panel, click the name of a class whose collected data you want
to analyze.  The Analysis Dates and Selected Data property pages for the class
are displayed in the Oracle Capacity Planner detail view.

5. To specify the selection criteria for the class of data you want to analyze, see
"Specifying Selection Criteria" on page 4-16 for instructions.

6. View the chart in the chart window.  The chart window contains two or more
pages.  The first page displays the chart and has the same name as the chart.
The remaining pages are Details pages.  A separate Details page exists for each
class from which one or more data items are included in the analysis.  Each
Details page shows the:

■ Data sources for the data items plotted in the chart



Creating a New Analysis

4-16 Getting Started with the Oracle Management Pack for Oracle Applications

■  Time aggregation level of the plotted data items

■ Value of each plotted data item each time the data item was collected
during the time range for the analysis

Specifying Selection Criteria
When a class is selected in the navigator panel in analysis view, a property sheet is
displayed that contains options available for selecting data from the Oracle
Capacity Planner historical database for that class.  After you set these selection
criteria, you can add the data to a new analysis chart or to an existing analysis chart.
To add the selected data to a new analysis chart, click Show New Chart, which
displays the new chart. To add the selected data to an existing analysis chart, open
that chart (as described in "Viewing and Modifying an Analysis" on page 4-17), click
Add to Chart, then in the Add Data to Analysis dialog box, select the name of that
analysis chart.

1. On the Analysis Dates property page, you specify the time aggregation level
and the time range of the class data that you want to analyze, as follows:

a. In the Select time aggregation level list box, choose the time aggregation
level for the data that you want to analyze.  That is, choose Hours if you
want to analyze hourly data, Days if you want to analyze daily data, and so
on.  The available dates and the number of rows of data at this aggregation
level for the selected class are displayed.

b. In the Specify the date range for selection section, choose the time range
for the collected data.  The time range you select determines which portion
of the collected class data is included in the analysis.  You can specify the
time range in one of the following ways:

* In terms of a time window relative to the current date.  For example,
you can specify that you would like to look at the most recent 7 days of
data for the selected time aggregation level.

This option is useful if you want to generate a report at a regular inter-
val.  For example, you can specify 7 days if you want to produce a
report every Monday morning that shows the hourly CPU statistics for
the previous week.  You do not need to reselect the time range every
Monday morning.

* By explicitly specifying a start and end time for the collected data you
want to analyze.

2. On the Selected Data property page, you specify which of the collected data
items from which data sources to include in the analysis, as follows:
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a. In the Data Sources section, choose one or more data sources whose data
items you want to analyze.  A check mark appears next to each data source
that is selected for analysis.

b. In the Data Items section, choose one or more data items you want to
analyze.  A check mark appears next to each data item that is selected for
analysis.

3. To add the selected data to a new analysis chart, click Show New Chart. To add
the selected data to an existing analysis chart, open that chart (as described in
"Viewing and Modifying an Analysis" on page 4-17), click Add to Chart, then in
the Add Data to Analysis dialog box, select the name of that analysis chart.
Note that only charts that are currently opened are displayed in the Add Data
to Analysis dialog box.

Viewing and Modifying an Analysis
You can view and modify both user-defined and predefined analyses.  However,
once modifications are made to a predefined analysis, the only way to save those
changes is to save the analysis to a new name.  This creates a new user-defined
analysis and preserves the original predefined analysis.

To view an existing analysis, which makes it available for modification, follow these
steps:

Note: You can add data items from multiple classes to an analysis,
and you can select different time aggregation levels and time
ranges for each class.  If an analysis contains a data item from a
given class and you modify the time aggregation level or time
range when you add a new data item from the same class to the
analysis, you receive a warning that the new time aggregation level
or time range values for the class will overwrite the existing values
for that class for the analysis.

For example, suppose that for an analysis, you ask Oracle Capacity
Planner to include data items from a particular class that are
aggregated at the Hour level.  If you later ask Oracle Capacity
Planner to include in the analysis some other data items from the
same class that are aggregated at the Day level, you will be asked
whether or not you want the new value (Day aggregation level) to
overwrite the existing value (Hour aggregation level) for the class.
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1. Expand the Analyses folder for the service, which displays the existing
predefined and user-defined analyses for the service. A bar chart icon identifies
predefined analyses.  A bar chart and person icon identifies user-defined
analyses.

2. Select a predefined analysis or user-defined analysis in the navigator panel.
The Analysis Summary property page for the selected analysis is displayed in
the detail panel.  The Analysis Summary property page displays the names of
the services and classes whose data is used in the analysis.

3. To view the data sources and data items in the analysis, click the plus (+) sign
next to the service icons in the Service/Source column.

4. To view the chart for the analysis, click Show.  Note that if you are opening a
predefined analysis, the Select Data Sources for Analysis dialog box is
displayed.  Predefined analyses are provided for certain Oracle products.
Predefined analyses require you to specify the available data sources for your
installation.  Select the data sources you want to include in the predefined
analysis and click OK.

After you have opened an analysis, you can modify the contents and how they are
presented.  See "Working with Analyses" on page 4-20 for more information.

You can also create a copy of an analysis, rename an analysis, or delete an analysis,
as explained in the next three sections.

Creating a Copy of an Analysis
You can create an analysis that is an exact copy of an existing analysis, but which
has a different name.  To do this:

1. If Oracle Capacity Planner is not already in analysis view, click the Analysis tab
in the Oracle Capacity Planner navigator panel.

Note: You can limit the list of displayed analyses to only
user-defined analyses by removing the check mark from the View
Predefined Analyses option on the File menu.  When you choose
the View Predefined Analyses option on the File menu again, the
check mark preceding the menu option is replaced, and predefined
analyses are displayed again.
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2. Expand the Capacity Planning folder in the navigator panel.  You are prompted
for connection information for the Oracle Capacity Planner historical database
that contains the collected data in which you are interested.

3. Expand the folder for the type of service in which you are interested.

4. Expand the service.

5. Expand the Analyses folder.

6. Select the analysis that you want to copy.

7. On the Analysis menu, choose Create Like.

8. In the Create Analysis Like dialog box, enter a unique name for the new
analysis that you are creating.

Renaming a User-Defined Analysis
You can rename a user-defined analysis.  To do this:

1. If Oracle Capacity Planner is not already in analysis view, click the Analysis tab
in the Oracle Capacity Planner navigator panel.

2. Expand the Capacity Planning folder in the navigator panel.  You are prompted
for connection information for the historical database that contains the collected
data in which you are interested.

3. Expand the folder for the type of service in which you are interested.

4. Expand the service.

5. Expand the Analyses folder.  A bar chart and person icon identifies
user-defined analyses.

6. Select the user-defined analysis that you want to rename.

7. On the Analysis menu, choose Rename.

8. In the Rename Analysis dialog box, enter a unique name for the analysis you
are renaming.
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Deleting an Analysis
You can delete an analysis.  To do this:

1. If Oracle Capacity Planner is not already in analysis view, click the Analysis tab
in the Oracle Capacity Planner navigator panel.

2. Expand the Capacity Planning folder in the navigator panel.  You are prompted
for connection information for the historical database that contains the collected
data in which you are interested.

3. Expand the folder for the type of service in which you are interested.

4. Expand the service.

5. Expand the Analyses folder.  A bar chart icon identifies predefined analyses,
and a bar chart and person icon identifies user-defined analyses.  Predefined
analyses cannot be deleted.

6. Select the user-defined analysis that you want to delete.

7. On the Analysis menu, choose Delete.

8. In the message dialog box that prompts you to confirm the deletion, click OK.

Working with Analyses
Once you have opened an analysis, either by selecting and showing an existing
analysis or by browsing collected data to create a new analysis, the data included in
that analysis is shown in the Oracle Capacity Planner analysis window.

The analysis window contains two or more pages.  The first page displays the
analysis chart and has the same name as the chart.  The remaining pages are Details

Note: After you make changes to a predefined chart, you can save
the modified version of the predefined chart as a new user-defined
chart.  You do this by specifying a unique chart name when Oracle
Capacity Planner prompts you regarding whether or not you want
to save the modifications to the predefined chart (see "Saving the
Results of a Predefined Analysis" on page 4-26 for more
information).  However, you cannot rename an unmodified
predefined chart.  This restriction ensures that the original
predefined charts are not overwritten.
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pages.  A separate Details page exists for each class from which one or more data
items are included in the analysis.  Each Details page shows the:

■ Data sources for the data items plotted in the chart

■ Time aggregation level of the plotted data items

■ Value of each plotted data item each time the data item was collected
during the time range for the analysis

The time range for the collected data appears along the bottom of each chart, with
the beginning of the time range at the left and the end of the time range at the right.

Two types of lines can appear on a chart.  Each solid line plots the values of a
selected data item during the specified time range. Each dashed line plots the result
of an extrapolation to time or extrapolation to value analysis for a data item.  The
result of each extrapolation (the time and value) is displayed in a small box on the
extrapolation line.  See "Specifying an Analysis Type" on page 4-24 for more
information on performing an extrapolation analysis.

The rest of this section describes other chart features.

Selecting a Line
When you view an analysis chart, you can perform certain operations after selecting
a line in the chart.  Most of the available operations are started by clicking a toolbar
button on the analysis window after a chart line is selected.  You select a line by
clicking the left mouse button on a point in the line.  When a line is selected, the
description of the line is displayed in the status bar at the bottom of the window,
and the appropriate toolbar buttons are enabled.

Operations available from the toolbar are also available on a pop-up menu.  To
display the pop-up menu, click the right mouse button on a line in the analysis
chart.

To be sure which line is currently selected (before clicking a toolbar button), read
the description of the line in the status bar.

Viewing the Value of a Data Point
To view the value for a data point (that is, one plotted point of a data item) on a line
in an analysis chart, position the cursor over the data point.  If there is a point
beneath the cursor, the date, time, and value for that data point displays in a box
above the point.
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Adding a Class of Data to an Analysis
After you have opened an analysis, you may want to add data from other classes to
the analysis.  To do this, follow these steps:

1. Confirm that the navigator is in analysis view.

2. Select from the navigator the class of data that you want to add.

3. Specify the selection criteria (as described in "Specifying Selection Criteria" on
page 4-16) for the class.

4. Click Add to Chart, then in the Add Data to Analysis dialog box, select the
name of the chart to which you want to add the data.

You can add data items from multiple classes to an analysis, and you can select
different time aggregation levels and time ranges for each class.  If an analysis
contains a data item from a given class and you modify the time aggregation level
or time range when you add a new data item from the same class to the analysis,
you receive a warning that the new time aggregation level or time range values for
the class will overwrite the existing values for that class for the analysis.

For example, suppose that for an analysis, you ask Oracle Capacity Planner to
include data items from a particular class that are aggregated at the Hour level.  If
you later ask Oracle Capacity Planner to include in the analysis some other data
items from the same class that are aggregated at the Day level, you will be asked
whether or not you want the new value (Day aggregation level) to overwrite the
existing value (Hour aggregation level) for the class.

Modifying Selection Criteria for a Class of Data Using the Set Options Feature
From the analysis window, you can modify the selection criteria associated with any
of the classes of data included in the analysis. Modify the selection criteria using
one of these methods:

■ Select a line in the analysis chart and click the Set Options toolbar button

■ Click the right mouse button on a line in the analysis chart and select Set
Options from the popup menu

■ Select the Data page in the analysis window for the class and click the Set
Options toolbar button

These actions display the Analysis Options dialog box, which contains the property
sheet for the class of data associated with the selected line.  This property sheet
contains the selection criteria for that class of data, which you can modify and apply
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to the current analysis. See "Specifying Selection Criteria" on page 4-16 for more
information.

After you modify selection criteria, you can click either Apply or OK on the
Analysis Options dialog box.  If you click Apply, the changes made to the selection
criteria are applied to the analysis and the updated analysis is shown. The Analysis
Options dialog box remains displayed, and you can make other modifications to the
same selection criteria, if you want.  If you click OK, the modifications are applied
to the analysis, and the Analysis Options dialog box is closed.

Removing a Line from a Chart
You can remove a line from an analysis chart by either of these methods:

■ select the line by clicking the right mouse button, then choose the Remove Line
option on the displayed menu

■ select the line, then click the Remove Line button on the analysis window
toolbar.

These actions remove the data for the selected data item from the chart, but not
from the historical database.

Excluding a Data Point from a Chart
You can exclude a data point (that is, one plotted point of a data item) from a chart
by selecting the data point, then choosing the Exclude Point option on the
displayed menu.  This is useful if you know that the value of a particular data point
is skewed.  For example, if you know that a particular CPU-intensive program was
not run at the usual time, you can remove the value for the % Processor Time data
item for that time from the chart. The selected data point is removed from the chart,
but the data for the data point is not removed from the historical database.

Once you have excluded data points for a line, when the line is selected, a red X
appears in the status bar to indicate that data points are excluded for that line.  You
can then click View Exclusions on the toolbar or click the right mouse button on the
line and select the View Exclusions option from the pop-up menu.

These actions display the Data Point Exclusions dialog box.  This dialog box
displays the current list of excluded points.  You can toggle the check mark for each
data point in the list.  An entry with the check mark displayed indicates that the
data point is excluded from the analysis.  To display an excluded data point in the
analysis again, click the check mark for the entry, clearing the check mark.  The
chart will be updated to include the points removed from the list of exclusions.
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Showing or Hiding the Chart Legend
You can control whether or not the legend is displayed in an analysis chart by
toggling the Show/Hide Legend button on the analysis window toolbar.  When the
legend is not shown, you can identify a line by clicking it, which displays the
description of the line in the analysis window status bar.

Auto-Scaling Data
If an analysis contains data from different classes where the scale of the data is
significantly different, you may want to apply scaling to the data.  Scaling
normalizes the data so that all lines have a maximum value of no greater than 100.
Very large data items are scaled down, and very small data items are scaled up.

To apply scaling, click Toggle Auto Scaling on the analysis window toolbar.  When
scaling is applied to a chart, data lines with very different scales may be visually
correlated.  When scaling is enabled, the Y-axis of the chart is displayed with the
label Scaled Data. Also, if you select a line from the chart by clicking it, the scaling
factor for that line is included in the status bar.

Specifying an Analysis Type
An extrapolation analysis infers or estimates by projecting and extending known
values.  Oracle Capacity Planner can perform the following types of extrapolation
analyses:

■ Extrapolation to time analysis

In an extrapolation to time analysis, you provide a goal time for a data item.
Oracle Capacity Planner uses the specified values in the historical database to
project the value of the data item at the goal time.

An extrapolation to time analysis is used to answer questions such as, "How full
will this disk be at the end of the year?"

■ Extrapolation to value analysis

In an extrapolation to value analysis, you provide a goal value for a data item.
Oracle Capacity Planner uses the specified values in the historical database to
project the time at which the data item will reach the goal value.

Note: Data point exclusions are not saved with an analysis.
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An extrapolation to value analysis is used to answer questions like, "When will
our CPU utilization reach 95 percent?"

Specifying and Performing an Extrapolation Analysis
To specify and perform an extrapolation analysis, follow these steps:

1. On the analysis chart, either:

■ Select a line by clicking a data point in the line, then click Extrapolate on the
toolbar.

■ Click the right mouse button on a data point in a line, then select
Extrapolate on the pop-up menu.

Both of these methods display the Extrapolate dialog box.

2. Using the Extrapolate dialog box, project (extrapolate) to a future date and time
or to a value, as follows:

■ To extrapolate to a future date and time, click Estimate the value at some
date and time and enter the time and date for which you wish to determine
a value.

■ To extrapolate to a value, click the Estimate date for a specified value and
enter a numeric value for which you wish to determine a date and time.

3. Click Estimate to calculate the result of the extrapolation analysis.

4. Next, you can set the options for including analysis results in the analysis chart.
If you do not want the chart changed, click Cancel to close the Extrapolate
dialog box.

5. To include the analysis results in the chart:

■ Select Show line fit for data but don’t extend line to plot a line through the
data points, showing the linear regression fit.  The line does not extend to
show the goal of the extrapolation.

■ Select Show line extended to resultant point to plot the line through the
data point, showing the linear regression fit, extended out to the point
indicated by the analysis results.  The end point of the line will be the
estimated point calculated from the date and time or value that you
specified.

■ Select Show extended line with annotation to include the plotted line
extended to the end point of the analysis and also an annotation.  The
annotation (or note) is displayed in a highlighted box with an arrow
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pointing to the end point of the line. By default, the annotation includes the
time and value for the end point.  You can customize this annotation box to
contain a note that relates to the analysis that you have performed.

To modify the default annotation, click Customize (which is available only
if you have chosen to include an annotation in the chart).  This displays the
Customize Annotation dialog box.  You can type text (including carriage
returns) into the Annotation text area.  The [T] token is used to display the
time, and the [V] token is used to display the value of the extrapolation
result.  Click OK to accept your customizations of the annotation, or click
Default to return to the default annotation.

6. Click either OK or Apply on the Extrapolate dialog box to update your analysis
chart with the extrapolation results.  If you click Apply, the chart is updated,
but the Extrapolate dialog box is not closed.  This gives you the opportunity to
view the results of the update and to fine-tune them.

Saving Analysis Results
You can save the results of an analysis.  Oracle Capacity Planner can determine if
you are saving the results of a user-defined analysis or a predefined analysis.  The
steps for saving analysis results differ, depending on the type of analysis.

Saving the Results of a User-Defined Analysis
To save the results of a user-defined analysis:

1. While viewing the analysis chart, click Save Chart on the analysis window
toolbar.

2. Click Yes in the message box, which places the chart in the Analyses folder of
the navigator panel.

Saving the Results of a Predefined Analysis
If you modify a predefined analysis, you must provide a new name for the analysis
when you save the analysis results.  When you do this, you create a new

Note: To move the annotation box in an analysis chart, click the
box, hold the mouse button down, then move the mouse to a
different position on the chart. Release the mouse button when you
have reached the position in the chart where you want the
annotation box displayed.



Understanding the Oracle Capacity Planner Historical Database

Introduction to Oracle Capacity Planner 4-27

user-defined analysis.  This ensures that the original predefined analysis is not
overwritten.

To save the results of a predefined analysis:

1. While viewing the analysis chart, click Save Chart on the analysis window
toolbar.

2. Click Yes in the dialog box that is displayed.

3. In the Save Analysis As dialog box, type a unique name for the user-defined
analysis that will be created.

4. Click OK in the Save Analysis As dialog  box, which places the new
user-defined chart in the Analyses folder of the navigator panel.

Printing an Analysis Chart
To print an analysis chart, click the Print Chart button while the chart is displayed.

The size of the chart on the screen determines the size of the chart in the chart
printout. For example, when you print a chart that is 5 inches high and 7 inches
wide on your screen, the chart will be 5 inches high and 7 inches wide in the
printout.

Generating a Report for an Analysis Chart
To generate a report for an analysis chart, click the Report Chart button while the
chart is displayed. This displays the Save HTML Chart Report dialog box, which
allows you to save a chart report in HTML format. After you specify the name of
the chart report file, Capacity Planner allows you to preview the report by
displaying it on your screen.

Note that regardless of the file type you specify for the report, the report is saved in
HTML format. You can view the report again later using a web browser.

Understanding the Oracle Capacity Planner Historical Database
The logical structure of the Oracle Capacity Planner historical database schema was
designed to facilitate querying of capacity planning data by tools other than Oracle
Capacity Planner, such as Microsoft Excel.  This section contains a brief description
of the design of the Oracle Capacity Planner historical database schema.  It is not
intended to be a comprehensive description of all tables and columns in the schema.
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Understanding the Service Reference Table (vp_service_ref)
The service reference table contains a list of all services for which data has been
stored in this Oracle Capacity Planner historical database.  The HOST column
contains the name of the host where the Agent data gathering service is located that
loaded data for the specified target (the NAME column).  The SVC_ID column is a
column used for lookup into the class reference table, described in the following
paragraph.

Understanding the Class Reference Table (vp_class_ref)
The class reference table contains a list of all collection classes for which data has
been stored in this Oracle Capacity Planner historical database, for all services.  To
see the list of classes for a particular service, a query should look for the SVC_ID
column equal to a SVC_ID value from the service reference table, described in the
previous paragraph. Such a query would produce a list of all classes for which data
exists in the database for a particular service.

Understanding the Data Tables
Each class of data contained in the class reference table has six data tables that
contain the data for that collection class.  Each table contains data for a particular
time aggregate, for example, hours, days, weeks, months, and years.  The base table
contains the raw data as it is collected at the collection frequency.  Therefore, the
base table does not contain any statistical aggregations.  The aggregate tables
contain aggregate statistics for each data item collected for that class.

Data Table Names
Data tables are named according to the first four columns of the class reference table
(in reverse order) plus the aggregate. Example 4–1 shows an entry for a collection
class in the class reference table.

Caution: Performing any modification to the Oracle Capacity
Planner historical database schema (tables, columns, or indexes) or
to the data itself is not recommended and is not supported.  Such
modifications may render your Oracle Capacity Planner historical
database schema unusable as a target to load or retrieve capacity
planning data.
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Example 4–1 A Collection Class Entry in the Class Reference Table

CLS_ID      MOD_ID     SVC_ID     IS_UDS      CONTAINER_CLASS_LABEL
---------- ---------- ---------- ---------- -------------------------------
         8          2          2          0 I/O

The collection class in Example 4–1 would have the data tables shown in
Example 4–2.

Example 4–2 Data Tables for a Collection Class

VP_0_2_2_8_BASE
VP_0_2_2_8_HOUR
VP_0_2_2_8_DAY
VP_0_2_2_8_WEEK
VP_0_2_2_8_MONTH
VP_0_2_2_8_YEAR

Data Table Contents
The first two columns of each data table are always the Timestamp column and the
data source name column.  The data source name column is essentially the class
name, for example, Logical Disk. In aggregate tables (tables other than BASE), the
third column is an accuracy calculation, which is not supported in this version of
Oracle Capacity Planner.

All subsequent columns contain the values for the data items collected for that class,
as they are actually named.  In aggregate tables, these columns are prefixed with a
two-character abbreviation for the aggregation statistic that the column contains.
Table 4–4 shows these abbreviations and their meanings.

Table 4–4 Prefixes Used for Column Names in Aggregate Tables

Prefix Meaning

AV Average

SM Sum

MN Minimum

MX Maximum

SD Standard deviation

VR Variance

CT Count
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These statistics are calculated for the set of data contained in that aggregate from
the next lowest level.  For example, a row in the DAY aggregate table contains
statistics calculated for all the entries in the HOUR table for that day.
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5
Concurrent Processing Tuning Assistant

The Concurrent Processing Tuning Assistant (hereafter referred to as the Tuning
Assistant) is a reporting mechanism that allows you to examine historical
processing information about Oracle Concurrent Processing requests and
concurrent managers. The Tuning Assistant provides information that assists you in
achieving better concurrent processing throughput by adjusting concurrent
manager assignments and request scheduling.

The Tuning Assistant provides several predefined reports which identify problem
areas in concurrent manager processing. The Tuning Assistant generates reports
directly against the information stored in the Oracle Application Object Library
tables.

Considerations When Using the Tuning Assistant
The following sections describe two points you should consider when using the
Tuning Assistant: performance and completeness of data.

Performance Considerations
Since the Tuning Assistant generates reports directly from information stored in the
Application Object Library tables, the amount of concurrent processing request data
has a direct impact on performance. A large amount of data can cause delays in
gathering the information necessary to display report data.

One method for improving Tuning Assistant performance in retrieving data is to
periodically use the SQL language ANALYZE command to compute statistics on
tables which the Tuning Assistant accesses. These tables include:

■ FND_APPLICATION_TL

■ FND_LOOKUPS
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■ FND_CONCURRENT_PROCESSES

■ FND_CONCURRENT_PROGRAMS

■ FND_CONCURRENT_PROGRAMS_TL

■ FND_CONCURRENT_QUEUES

■ FND_CONCURRENT_QUEUES_TL

■ FND_CONCURRENT_REQUESTS

■ FND_USER

See the Oracle SQL documentation for information on how to use the SQL
ANALYZE command and the impact it may have on your system.

Completeness of Data
If the concurrent processing tables are purged frequently or if concurrent manager
and request data are purged at different intervals, the usefulness of the data
displayed in the reports could be limited.

When looking at information presented by the Tuning Assistant, be aware of the
data purge policies of your system administration and the effect these policies may
have on the data reported.

Usage Scenarios for the Tuning Assistant
The following section provides two scenarios of how you might use the reports to
tune your request schedules: concurrent manager balancing and concurrent
manager specialization.

Concurrent Manager Balancing
To determine concurrent manager balancing, view the Waiting Requests by Hour
(24 x 7) report and look for the time periods with the greatest wait times.

If you find a time period that seems to have a relatively great number of backups,
examine which requests were run and which requests were waiting during this time
period. For selected time periods, drill down to the Requests that Waited report to

Note: Tuning Assistant reports do not include currently running
requests. Only completed requests are included in reports.
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identify the requests that waited. It may be necessary to schedule these requests
during periods with excess concurrent manager capacity.

To find time periods with excess concurrent manager capacity, examine the
Concurrent Managers by Hour (24 x 7) report, and look for underutilized time
periods. For details about activity during selected time periods, drill down to the
Requests that Ran report.

To reduce wait time, consider rescheduling a program to run when the concurrent
managers have excess capacity. Use these reports to identify requests whose
schedules can be adjusted to distribute load more evenly.

If all concurrent managers are running at near or maximum capacity, it may be
necessary to add more concurrent managers. If system resources are also fully
utilized, it may be necessary to add additional hardware to support processing
demands.

Concurrent Manager Specialization
Designating certain concurrent managers to process either short or long running
programs can help to mitigate queue backup. Designating a concurrent manager to
process short running jobs can help to prevent short running jobs from getting stuck
behind long running jobs.

Look at the Long Running Requests report to determine if any of these requests
should be associated with a concurrent manager that will handle long running jobs.

Additionally, look at the Short Running Requests that Waited report to identify if
any of these requests should be associated with a concurrent manager that will
handle short running jobs.

Starting the Tuning Assistant
You can access the Tuning Assistant in the following ways:

■ From the Oracle Enterprise Manager console

■ From the Start menu

The following sections explain how to use these methods.

Starting the Tuning Assistant from Oracle Enterprise Manager
To start the Tuning Assistant from Oracle Enterprise Manager, highlight the
concurrent manager you want to investigate and do one of the following:
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■ Click the Application Management drawer and select Concurrent Processing
Tuning Assistant

■ Select Tools=>Application Management=>Concurrent Processing Tuning
Assistant

■ Select a Concurrent Manager in the navigator tree, click the right-mouse button,
and select Related Tools=>Concurrent Processing Tuning Assistant

The Tuning Assistant is displayed. However, if preferred credentials have not been
set or if they are incorrect, the Concurrent Processing Tuning Assistant Login dialog
box is displayed. Provide the login information to connect to a valid Applications
schema.

Starting the Tuning Assistant from the Start Menu
To start the Tuning Assistant from the Start menu, select
Start=>Programs=>ORACLE_HOME=>Application Management =>Concurrent
Processing Tuning Assistant. The Concurrent Processing Tuning Assistant Login
dialog box is displayed. Provide the login information to connect to a valid Oracle
Applications schema.

Once a connection has been established, the Tuning Assistant will ensure that it is a
valid schema containing Oracle Application Object Library tables.

Using the Tuning Assistant
The following options are available in the Tuning Assistant:

■ Tuning Assistant Main Window

■ Displaying Reports

■ Saving Reports

■ Report Properties

■ Drill-Down from Tuning Assistant Reports

■ Printing Tuning Assistant Reports

Note: ORACLE_HOME represents the Oracle home in which the
Tuning Assistant is installed.
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Tuning Assistant Main Window
The Tuning Assistant main window consists of two panes: a pane with a report tree
and a Report Detail pane. The report tree presents a list of available reports
organized by categories: concurrent managers, programs, and requests.

The Report Detail pane contains the General and Options tabs.

General Tab
The General tab contains a thorough description of the contents of the report and
why the report is useful.

Options Tab
The Options tab shows the current settings for the reporting options, for example,
the reporting period, applications included in the report, and requests included in
the report. Change the settings in this tab to retrieve the data in which you are most
interested. Of the following options, only those appropriate for the particular report
will display.

■ Reporting Period

The Reporting Period group includes alternative options, such as previous
week, previous four weeks, one week starting, and time period. The time
period will be initialized to the minimum and maximum dates available in the
current applications schema.

■ Application Included in Report

With this option, you can select either one application to be represented in the
report or all available applications to be represented. By default, all applications
are included.

■ Requests Included in Report

The Requests Included In Report option has various settings based on the type
of report you selected. These settings include:

– Minimum Duration

Only requests with a duration greater than the minimum duration will be
included in the report.

– Minimum Wait Time

Only requests that waited longer than or equal to the minimum wait time
will be included in the report.
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– Maximum Wait Time

Only requests that waited less than or equal to the maximum wait time will
be included in the report.

– Maximum Runtime

Only requests that ran for less time than the maximum runtime will be
included in the report.

For each of these options, enter a value in the text field and select the time
granularity. The time granularity options are minutes, hours, days, and weeks.
If you do not want an available option, set its time granularity to None.

■ Limit the Number of Rows Retrieved

With this option you can limit the number of rows retrieved to a value you
specify. Only the number of rows specified are included in the report. If you do
not specify the number of rows, all rows that meet the criteria for inclusion are
displayed in the report.

Displaying Reports
To display reports, you can either click Show Report on the Report Detail pane or
double click on the report node on the report tree.

When a report is opened, information is retrieved from the Application Object
Library tables. As the Tuning Assistant retrieves the data, a busy bar appears at the
bottom of the display. Some reports will show intermediate data in the display area.
If the busy bar is still visible, this indicates that the data is still being retrieved.

A Cancel button is displayed next to the busy bar. Click Cancel to interrupt an
operation. Depending on the type of operation that is being performed, the cancel
operation may or may not be processed immediately. If partial data is available,
Cancel will stop the data retrieval and display the results that were retrieved before
the cancellation occurred.

The following are additional characteristics about the reports:

■ Clicking column headers in these reports causes data to be sorted by the
selected column header, if the report is not a "by hour (24x7)" report.

■ Some reports present a drop-down list at the top of the display to filter the
information that is being displayed, or to change the format of the information
that is being displayed.
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Saving Reports
To save reports, click Save As on the toolbar.

Reports can be saved to a file in comma-separated value (CSV) format or Hypertext
Markup Language (HTML) format. The file will contain the data that was retrieved
for this report. Files saved in CSV format can be uploaded into spreadsheet
applications. Files saved in HTML format can be viewed using a Web browser.

For reports that provide you with the ability to manipulate the displayed data, the
Tuning Assistant saves the data as it is currently displayed.

Report Properties
To show reports, click Report Properties on the toolbar.

The Report Properties option displays information about a report, for example,
options selected. Report Properties include the General and Options tabs as in the
report detail pane, as well as a SQL Text tab that displays the SQL text used to
generate the report. Drill-down reports include a Drill Source tab which includes
information about the parent report for this drill-down report.

Some reports provide the ability to modify or change report properties and
redisplay the report with the changed settings.

Drill-Down from Tuning Assistant Reports
To drill down to a report, click Drill-Down on the toolbar.

Many reports have a drill-down capability. These reports will drill down to data
associated with the currently selected items.

Printing Tuning Assistant Reports
To print reports, click Print on the toolbar.

The Print option prints the data that is currently displayed in the report window.

Report Descriptions
The following reports are available through the Tuning Assistant:

■ Concurrent Managers by Hour (24x7)

■ Concurrent Manager Usage by Program
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■ Program Run Summary by Status

■ Program Wait Summary

■ Waiting Requests by Hour (24x7)

■ Long Running Requests

■ Short Running Requests that Waited

■ Request Run Summary by Month

■ Drill-Down Reports

– Requests that Ran

– Requests that Waited

– Request Details

Concurrent Managers by Hour (24x7)
The Concurrent Managers by Hour (24 x 7) report answers the question, "How is
my Concurrent Manager capacity being used?"

The purpose of this report is to identify time periods when concurrent managers
had excess capacity. This report shows the percentage of time each concurrent
manager was actually utilized for a block of time periods. By examining the time
jobs were run in a concurrent manager against its total capacity, you determine
capacity utilization.

This report shows the days of the week in columns and hourly time periods in
rows. Each slot in the display contains the utilization for that concurrent manager
during that time period. This report provides a graphical display using color to
show time period utilization: red (greatest utilization), yellow (less utilization), and
gray (no utilization).

Because this report displays data in a weekly format (24 x 7), when you choose a
time period that extends beyond a week, the data displayed is the sum of the data
for each hour over the time period. For example, if the time period extends from
Monday to Monday (8 days), the Monday column in the report displays the sum of
the data for the two separate Mondays.

The features of this report include:

■ Selecting individual or all concurrent managers from the Concurrent Manager
drop-down list. Concurrent managers prefixed with an asterisk (*) were
available for the time period specified in the report options but serviced no
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requests. In other words, the concurrent managers were running but they did
no work.

■ Selecting the type of data displayed from the Data Displayed drop-down list.
Types of data include:

– Concurrent Manager Utilization shows the percentage of concurrent
manager capacity that was used. This percentage is calculated by dividing
the number of minutes requests were run by the number of minutes of
concurrent manager capacity available.

– Concurrent manager capacity in minutes

– Request runtime in minutes

– Number of requests that ran

– Request runtime to concurrent manager capacity ratio shows the ratio of
concurrent manager capacity that was used. This ratio is calculated by
dividing the number of minutes requests were run by the number of
minutes of concurrent manager capacity available.

– Concurrent manager utilization fraction shows the fraction of concurrent
manager capacity that was used. This fraction is calculated by dividing the
number of minutes requests were run by the number of minutes of
concurrent manager capacity available.

■ Customizing the high utilization threshold using a slider. The slider controls the
color each hour is displayed in. Any hours with a concurrent manager
utilization greater than the slider value will be displayed in red.

For this report you can drill down to the Request that Ran report. Select one or more
time periods and choose drill down from the toolbar.

Concurrent Manager Usage by Program
The Concurrent Manager Usage by Program report answers the question, "Which
programs ran on which concurrent managers?"

You can use this information to determine which concurrent manager and program
combinations are potential bottlenecks.

For a given time period, this report provides the following information:

■ Concurrent manager name

■ Program name
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■ Duration in minutes: total, average, minimum, and maximum (the report is
sorted by total duration)

■ Number of times the program ran in this concurrent manager

Program Run Summary by Status
The Program Run Summary by Status report answers the question, "Which
programs ran and how long did they take to run?"

This report provides general information about requests summarized by program
and grouped by status:

■ Application

■ Program

■ Duration in minutes: total, average, minimum, and maximum (the report is
sorted by total duration)

■ Number of times run

■ Status

From this report you can drill down to the Requests that Ran report. Select one or
more rows and choose drill down from the toolbar.

Program Wait Summary
The Program Wait Summary report answers the question, "Which programs had to
wait and how long did they wait?"

With this report you can identify programs that have historically long wait times.
This information can be used to identify which programs may benefit most from a
change in program scheduling. This report provides the following information:

■ Application

■ Program

■ Actual wait time (in minutes): total, average, minimum, and maximum (the
report is sorted by total wait time)

■ Number of times run

From this report you can drill down to the Requests that Waited report. Select one
or more rows and choose drill down from the toolbar.
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Waiting Requests by Hour (24x7)
The Waiting Requests by Hour (24 x 7) report answers the question, "What are my
problem time periods?"

The resulting report shows the days of the week in columns and hourly time
periods in rows. Each square in the display contains the amount of time requests
waited (in minutes) during that time period.

This report presents a graphical display, showing time periods with the longest wait
times in red, middle wait times in yellow, and no wait times in the default
background color.

The graphical display of this data is useful when tuning concurrent managers by
adjusting job schedules and by visually locating the "hot", "warm", and "cold" time
periods. You can use this information to adjust request scheduling.

The features of this report include:

■ Selecting an individual program or all programs from the Programs list.

■ Selecting the type of data from the Data Displayed drop-down list. The
available types of data are:

– Minutes requests spent waiting

– Number of requests that waited

■ Customizing the threshold for "hot" and "warm" periods using a slider.

From this report you can drill down to the Requests that Waited report. Select one
or more time periods and choose drill down from the toolbar.

Long Running Requests
The Long Running Requests report answers the question, "Which jobs took a long
time to run?"

This report shows runtimes for requests started during a given time period that
took longer than n minutes to run. This helps you identify slow requests.

A possible remedy for slow requests is to schedule requests during off-peak hours.
This report also identifies programs which should run in a particular concurrent
manager. You can designate a slow concurrent manager and a fast concurrent
manager. Long running jobs should be delegated to the slow concurrent manager
and faster jobs delegated to the fast concurrent manager. This prevents fast jobs
from being blocked by a slow job, increasing overall throughput.
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For all requests with a duration greater than a specified number of minutes, this
report provides the following information:

■ Program name

■ Duration in minutes (the report is sorted by this column)

■ Request ID

■ User name

■ Concurrent manager name

■ Actual start date

■ Status

■ Priority

■ Arguments

■ Request limit (if available)

From this report you can drill down to the Request Details report. Select a request
and choose drill down from the toolbar.

Short Running Requests that Waited
The Short Running Requests that Waited report answers the question, "Which
requests waited a long time relative to their runtime?"

This report lists the short running jobs that queue longer than a specified number of
minutes.

This report is useful for determining which requests are waiting a relatively long
time compared to their runtime. Requests can wait longer than they run. If many
requests are identified, consider creating a concurrent manager that specializes in
short running requests. This may help to increase the throughput of these requests.

This report provides information on:

■ Program name

■ Wait time (the report is sorted by this column)

■ Duration

■ Request ID

■ Phase meaning
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■ Status meaning

■ Earliest start

■ User name

■ Concurrent manager name

From this report you can drill down to the Request Details report. Select a report
and choose drill down from the toolbar.

Request Run Summary by Month
The Request Run Summary by Month report answers the question, "How has my
request processing changed over time?"

You can use this information to determine on a monthly basis if overall
performance is improving or deteriorating on a month-to-month basis. The average
duration of a request (in minutes) is a good indicator of the change in system
performance over time.

You can also use this report to note if the number of requests processed is increasing
over time.

This report provides information on:

■ Total duration in minutes

■ Total and average request runtime (duration) in minutes

■ Number of requests that ran during the month

Drill-Down Reports
Drill-down reports display information that is in the context of the report from
which the drill-down was invoked. For example, from the Concurrent Managers by
Hour (24x7) report you can drill-down to the Requests that Ran report.

Requests that Ran
The Requests that Ran report answers the question, "What requests ran in the
drill-down context?"

For all requests that ran in this context, this report provides the following
information:

■ Program name
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■ Duration in minutes (the report is sorted by this column)

■ User name

■ Concurrent manager

■ Actual start time

■ Actual completion time

■ Priority

■ Request ID

■ Constrained request (yes or no)

■ Single threaded (yes or no)

■ Status

■ Request limit (if available)

From this report you can drill down to the Request Details report. Select a request
and choose drill down from the toolbar.

Requests that Waited
The Requests that Waited report answers the question, "What requests waited in the
drill-down context?"

For all requests that waited in this context, this report provides the following
information:

■ Program name

■ Wait length in minutes (the report is sorted by this column)

■ User name

■ Concurrent manager that ran request

■ Run alone

■ Priority

■ Single threaded

■ Earliest possible start

■ Actual start

■ Actual end
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■ Request ID

■ Request limit

■ Constrained request (yes or no)

■ Request limit (if available)

From this report you can drill down to the Request Details report. Select a request
and choose drill down from the toolbar.

Request Details
The Request Details report answers the question, "What are the details for a given
request ID?"

You can drill down to this information from any report that shows individual
requests. This information is compatible with the request detail information
presented by Oracle Applications Manager.

This report provides information on:

■ Request ID

■ User name

■ Priority

■ Language

■ Phase

■ Status

■ Submission date

■ Requested start date

■ Actual start date

■ Actual completion date

■ Completion text

■ Arguments
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6
Oracle Applications Advanced Events

The Oracle Applications Advanced Events include a library of applications-specific
events which are provided for lights-out event monitoring and problem detection of
the Applications system.

Aside from the basic updown event tests provided for all services administered in
the Oracle Enterprise Manager console, the Management Pack for Oracle
Applications provides a library of advanced event tests specific to Oracle
Applications subsystems.

The Application subsystem specific events notify administrators of the following
problems:

■ Run Alone Request Submitted

■ Inactive Request Pending

■ Request Error Rate

■ Request Warning Rate

■ Request Pending Time

■ Pending Concurrent Request Backlog

■ CRM Waiting on a Lock

■ ICM Waiting on a Lock

■ Concurrent Manager UpDown

■ Concurrent Manager Disk Free

Note: To successfully use the event tests, the node credentials on
NT must be for a user with the "logon as batch" privilege.
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The Oracle Applications event library also includes several node events. These
events monitor for severe conditions on the system:

■ Data Gatherer Alert

■ Disk Full

■ Disk Full (%)

■ Swap Full

■ CPU Utilization

■ CPU Paging Rate

Concurrent Manager Event Tests

Run Alone Request Submitted
This event monitors the characteristic of the requests submitted to the Concurrent
Manager(s). If a request is submitted as a runalone request, an alert in generated.

Parameters
None

Output
The number of run alone requests in the concurrent manager(s) queue.

Default Frequency
60 seconds

Note: For more information on submitting or scheduling events,
please refer to the Oracle Enterprise Manager Administrator’s Guide.
Pay special attention to the event frequency value, which can be set
on the General tab of the create event panel. This value determines
the frequency of polling for event occurrence. The default value is
every 60 seconds, but for many application management events,
you may wish to choose larger values, for better performance and a
lower overall impact on system resources.
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User Action
Determine whether or not the run alone request submitted is necessary. If it is not,
the request should be killed so that other requests can be processed.

Inactive Request Pending
This event monitors the state of the requests submitted to the Concurrent
Manager(s). If any of the requests is in an inactive state, an alert is generated.

Parameters
None

Output
The number of inactive requests in the concurrent manager(s) queue.

Default Frequency
60 seconds

User Action
Locate the inactive request and remove it from the queue.

Request Error Rate
This event monitors the error rate of concurrent requests. When the error rate
reaches the threshold parameters set by the user, an alert or warning is generated.

Parameters
1. Alert threshold: Percentage of requests marked with errors for alert. Default

10%.

2. Warning threshold: Percentage of requests marked with errors for warning.
Default 5%.

Output
Percentage of requests with errors.

Default Frequency
60 seconds

User Action
Look at the Request Log files in the APPL_TOP/log directory to determine which
requests need to be corrected.
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Request Warning Rate
This event monitors the warning rate of concurrent requests. When the warning
rate reaches the threshold parameters set by the user, an alert or warning is
generated.

Parameters
1. Alert threshold: Percentage of requests marked with warning for alert. Default

10%.

2. Warning threshold: Percentage of requests marked with warnings for warning.
Default 5%.

Output
Percentage of requests with warnings.

Default Frequency
60 seconds

User Action
Look at the Request Log files in the APPL_TOP/log directory to determine which
requests need to be corrected.

Request Pending Time
This event monitors for requests which have been in the pending state for a time
period exceeding the threshold, set by the user.

Parameters
1. Hours pending: Number of hours the request has been pending. Default 1 hour.

2. Minutes pending: Number of minutes the request has been pending. Default is
30 minutes.

Output
Number of hours or minutes that the request has been pending.

Default Frequency
60 seconds

User Action
Check to see if the queue is being serviced actively. Increase the processes for the
Concurrent Manager to balance the load, if necessary.
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Pending Concurrent Request Backlog
This event monitors for concurrent requests which have been in the pending state
for a time period exceeding the threshold, and triggers an alert if they exceed the
'total concurrent requests' threshold.

Parameters
1. Threshold for total number of requests pending: Number of requests pending

in the queue. Default 1.

2. Time Threshold in minutes for including requests in the pending queue
backlog. Default 1 minute.

Output
Number of requests currently pending.

Length of time the requests has been pending in queue.

Default Frequency
60 seconds

User Action
Increase the number of concurrent processes to handle the load.

CRM Waiting on a Lock
This event checks to see if the Conflict Resolution Manager is waiting to get a lock.
If the lock wait time reaches a specified amount of time, a warning is issued.

Parameters
1. Alert Threshold: Lock wait time (in minutes) for an alert. Default 3 minutes.

2. Warning Threshold: Lock wait time (in minutes) for a warning. Default 2
minutes.

Output
Session identification number

Operating system process identification number

Lock mode

Note: Threshold values must be between 2 and 32 minutes.
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Machine name

Terminal name for the locking session

Default Frequency
60 seconds

User Action
Locate the session that is blocking the Conflict Resolution Manager and determine if
the session can be killed.

ICM Waiting on a Lock
This event checks to see if the Internal Concurrent Manager is waiting to get a lock.
If the lock wait time reaches a specified amount of time, a warning is issued.

Parameters
1. Alert Threshold: Lock wait time (in minutes) for an alert. Default 3 minutes.

2. Warning Threshold: Lock wait time (in minutes) for a warning. Default 2
minutes.

Output
Session identification number

Operating system process identification number

Lock mode

Machine name

Terminal name for the locking session

Default Frequency
60 seconds

Note: A fixit job could be registered to automatically kill the
blocking session when the event is triggered.

Note: Threshold values must be between 2 and 32 minutes.
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User Action
Locate the session that is blocking the Internal Concurrent Manager and determine
if the session can be killed.

Concurrent Manager UpDown
This event monitors the state of the Internal Concurrent Manager (ICM). If the ICM
goes down, an alert is generated.

Parameters
None

Output
None

Default Frequency
60 seconds

User Action
Submit a standalone Concurrent Manager startup job when the event issues an
alert. The startup Concurrent Manager job could also be configured as a fixit job to
automatically restart the ICM when it goes down.

Concurrent Manager Disk Free
This event monitors the growth rates of the log, output, and other uses for its
concurrent requests. A checkbox is provided to select any or all of these partitions.

Parameters
1. Alert Threshold for Log: Free space threshold in percentage. Default is 30%.

2. Warning Threshold for Log: Free space threshold in percentage. Default is 50%.

3. Alert Threshold for Output: Free space threshold in percentage. Default is 30%.

Note: A fixit job could be registered to automatically kill the
blocking session when the event is triggered.

Note: This event requires the Application environment file
specified in the oapps.ora file on the managed node.
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4. Warning Threshold for Output: Free space threshold in percentage. Default is
50%.

5. Name of partition. (’*’ is not a supported name.)

6. Alert Threshold for Other Partition: Free space threshold in percentage. Default
is 30%.

7. Warning Threshold for Other Partition: Free space threshold in percentage.
Default is 50%.

Output
Partition name and space available in percentage on the partition.

Default Frequency
60 seconds

User Action
Purge the log or output files.

Node Events

Data Gatherer Alert
This event test signifies that the Data Gatherer has generated errors to the Data
Gatherer alert file since the last sample time. The Data Gatherer alert file is a special
trace file containing a chronological log of messages and errors. Note that the Data
Gatherer alert log file is different than the Database alert log file. An alert is displayed
when Data Gatherer (ODG-xxxxx) messages are written to the Data Gatherer alert
file.

Parameters
None

Note: You can configure the ’Run OS Command’ job task as a fixit
job to remove the log/output files from the Oracle Applications
APPL_TOP.

Please refer to the Oracle Enterprise Manager Administrator’s Guide
for more information on configuring job tasks.
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Output
Alert log error messages since last sample time.

Default Frequency
60 seconds

User Action
Examine Data Gatherer alert log for additional information.

Disk Full
This event test checks for available space on the disk specified by the Disk name
parameter. If the space available is less than the values specified by the thresholds,
then a warning or alarm is generated.

Parameters
1. Disk name: Name of the disk to be monitored. No default is provided.

2. Alert threshold: Free space threshold in kilobytes for alert. No default is
provided.

3. Warning threshold: Free space threshold in kilobytes for warning. No default is
provided.

Output
Disk name and space available in kilobytes on the disk.

Disk Full (%)
This event test monitors the same file systems as the Disk Full event test. The Disk
Full (%) event test, however, returns the percentage of space remaining on the disk
destinations.

Parameters
1. Disk name: Name of the disk to be monitored. No default is provided.

Note: "*" is not a supported disk name.

Note: "*" is not a supported disk name.
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2. Alert threshold: Percentage of free space threshold for alert. Default is 30%.

3. Warning threshold: Percentage of free space threshold for warning. Default is
50%.

Output
Disk name and percentage of space available on the disk.

Swap Full
This event test checks for available swap space. If the space available falls below the
values specified in the threshold arguments, then a warning or alarm is generated.

Parameters
1. Alert threshold: Free space threshold in percentage for alert. No default is

provided.

2. Warning threshold: Free space threshold in percentage for warning. No default
is provided.

Output
Current used space in percentage.

CPU Utilization
This event test checks for the CPU utilization (percentage used) against the
threshold values specified by the threshold arguments. If the number of occurrences
exceeds the values specified, then a warning or alarm is generated.

Parameters
1. Number of occurrences: Number of consecutive occurrences before an alert is

generated.

2. Alert threshold: Threshold for alert (%). No default is provided.

3. Warning threshold: Threshold for alert (%). No default is provided.

Output
Current utilization.
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CPU Paging Rate
This event test checks the paging rate (kilobytes/second paged in/out) against the
threshold values specified by the threshold arguments. If the number of occurrences
exceeds the values specified, then a warning or alarm is generated.

Parameters
1. Number of occurrences: Number of consecutive occurrences before an alert is

generated.

2. Alert threshold: Alert threshold for alert (kilobytes/second). No default is
provided.

3. Warning threshold: Warning threshold for warning. No default is provided.

Output
Current rate.



Node Events

6-12 Getting Started with the Oracle Management Pack for Oracle Applications



Oracle Applications Jobs 7-1

7
Oracle Applications Jobs

The job tasks and job scheduling services of the Oracle Enterprise Manager console
allow you to automate standard and repetitive tasks, such as executing a SQL script
or executing an operating system command. The Management Pack for Oracle
Applications includes job tasks that can be configured to bring a concurrent
manager up or down. The pack also includes job tasks that can be configured to
trigger automatically as fixit jobs for a particular event. Jobs can be scheduled for
specific times or time intervals allowing the administrator to proactively monitor
and correct problems.

This chapter describes each of the jobs included with the Management Pack for
Oracle Applications. For more information on submitting or scheduling jobs, please
refer to the Oracle Enterprise Manager Administrator’s Guide.

Setting Concurrent Manager Node Credentials
Prior to using the Oracle Applications Jobs, you must set the Concurrent Manager
Node Credentials. This is necessary because on Unix, all jobs executed by the Oracle
Intelligent Agent are performed as the OS specified in the preferred credentials for
that node. This may present an Oracle Applications administrator with a problem if
the APPL_TOP for the Concurrent Processing server is owned by an OS user, such
as "applmgr", which is different from the OS user, "oracle", which is needed to
perform database operations.

The following are four suggestions for how to work around this problem:

1. Set the preferred node credentials to use "applmgr" as the OS user instead of
"oracle".

2. Keep the user "oracle" in the preferred node credentials. Allow the ICM to be
started as user "oracle". All log and output directories must be writable by
"oracle". The users "oracle" and "applmgr" should belong to the same group.
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You may need to set the umask in the .login files of these users to ensure that
files created in the Concurrent Manager's environment have the appropriate
group permissions.

3. Keep the user "oracle" in the preferred node credentials. Configure the .rhosts
file for "applmgr" so that the user "oracle" can rsh to the managed node as the
user "applmgr". Alter the concurrent manager startup script ($FND_
TOP/bin/oemstart.sh, for example) to rsh as "applmgr" to the managed node
and start the Concurrent Manager.

For example, if your Intelligent Agent is on "prodapps.acme.com" add the
following line to the .rhosts file for the user "applmgr":

prodapps.acme.com oracle

The concurrent manager startup script should then read:

rsh -l applmgr prodapps.acme.com ".$1;startmgr sysmgr=$2"

4. Change the oemstart.sh script to be set-user-id (suid), owned by the APPL_TOP
owner "applmgr."

Concurrent Manager Shutdown
The Concurrent Manager Shutdown Job shuts down the Internal Concurrent
Manager (ICM), in the mode specified by the user.

When configured in the abort mode, the job shuts down the ICM regardless of the
existing state of the queues.

When configured in the stop mode, the job waits until current requests are
processed and completed before stopping the ICM.

Parameters
1. Stop

2. Abort

Choose the Stop mode if you would like to bring down the ICM graciously, and the
Abort mode, if you would like to bring down the ICM immediately, regardless of
the state of the Concurrent request queues.

Output
1. Completion status of the job

2. Name of user who registered the job

3. Name of target database
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User Action
If the job fails, check the ICM log file in the log directory in the APPL_TOP to
determine why the ICM failed to stop.

Concurrent Manager Startup
The Concurrent Manager Startup job task starts the Internal Concurrent Manager
(ICM). This job task can be configured as a fixit job to be associated with the
Concurrent Manager UpDown event test to automatically start up the Concurrent
manager (ICM) when it goes down.

Parameters
No parameters required

Output
1. Completion status of the job

2. Name of user who registered the job

3. Name of target database

User Action
If the job fails, check the ICM log file for details. If the environment variable
APPLCSF is set, then the ICM log file will be located in $APPLCSF/$APPLLOG.
Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.

Kill Locking Session
The Kill Locking Session job task is intended to be used as a fixit job for the
following Oracle Applications Advanced Event Tests:

■ ICM Waiting on a Lock

■ CRM Waiting on a Lock

When configured as a fixit job for the above event tests, the session preventing
ICM/CRM from continuing would automatically be killed.

Parameters
No parameters required.

Output
User will be informed if the job succeeds.
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User Action
If the job fails, check the ICM log file for details. If the environment variable
APPLCSF is set, then the ICM log file will be located in $APPLCSF/$APPLLOG.
Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.
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A
Charts and Chart Groups

This appendix describes the application charts and chart groups available in Oracle
Performance Manager. Some of these charts provide the ability to perform
administrative tasks, for example, canceling a request.

The types of charts available are:

■ System Overview Charts and Chart Groups

■ Form Sessions Charts and Chart Group

■ Concurrent Requests Charts and Chart Groups

■ Concurrent Managers Charts and Chart Group

■ Database Session Charts

Standby and Pending Requests
The charts and classes in the Management Pack for Oracle Applications use the
following definitions of standby requests and pending requests. These definitions
do not directly correspond to the Applications phase and status codes for
concurrent requests. For example, a standby request in the Management Pack for
Oracle Applications might have any of the following phase/status combinations:
Pending/Scheduled, Pending/Standby, or Inactive/No Manager.

Standby Requests
Standby requests have constraints that need to be evaluated by the Conflict
Resolution Manager before they can run. Constraints include incompatibilities with
other requests, single-threaded requests, run-alone requests, and user level active
request limits. When a standby request is released by the Conflict Resolution
Manager, it becomes a pending request.
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Pending Requests
Pending requests include all non-standby requests that have not yet run.

System Overview Charts and Chart Groups
The Overview charts and chart groups provide a summary of system performance
by presenting a variety of performance indicators in a single screen.

System Activity Overview Chart Group
This chart group pulls together interactive user and concurrent request information
to give an overview of system activity.

This group contains the following charts:

■ Form Sessions and Concurrent Requests Chart on page A-2

■ Longest Running Requests Chart on page A-9

■ Completed Requests by Status Chart on page A-10

■ Pending Requests per Manager Chart on page A-12

■ Running Requests per Manager Chart on page A-13

Top Resource Consumers Chart Group
This chart group identifies the processes consuming the greatest amounts of a
specified resource in an Applications system.

This group contains the following charts:

■ Top Form Sessions Chart on page A-3

■ Top Running Requests Chart on page A-9

Form Sessions and Concurrent Requests Chart
The Form Sessions and Concurrent Requests chart displays the number of open
form sessions, the number of standby requests, the number of pending requests,
and the number of running requests.

You can drill down to the following charts:

■ Current Form Sessions Chart on page A-3

■ All Standby Requests Chart on page A-11
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■ All Pending Requests Chart on page A-11

■ All Running Requests Chart on page A-11

Form Sessions Charts and Chart Group
The Form Sessions charts show performance indicators for interactive Oracle
Applications sessions.

Form Sessions Summary Group
The Form Sessions Summary chart group gives an overview of active sessions per
user, application, and responsibility.

This group contains the following charts:

■ Form Sessions per User Chart on page A-4

■ Form Sessions per Application Chart on page A-4

■ Form Sessions per Responsibility Chart on page A-5

Current Form Sessions Chart
The Current Form Sessions chart shows the currently active form sessions. You can
set the collection options for this chart to limit the number of rows returned.

For a given form session, you can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14.

Top Form Sessions Chart
The Top Form Sessions chart shows form sessions consuming the greatest amounts
of a specified resource. You can choose from the following resources in the
collection options: Session UGA Memory, Session PGA Memory, CPU Used by this
Session, Physical Reads, Physical Writes, Open Cursors, User Commits, and User

Note: Information on form sessions is collected through the
Oracle Applications Sign-on Auditing feature. The profile "Sign-on:
Audit Level" must be set to "FORM" within Oracle Applications to
enable form sessions information to be collected. If the profile
"Sign-on: Audit Level" is not set to "FORM" then the form session
charts will not contain any data.
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Rollbacks. Also, the number of rows displayed by this chart can be limited in the
collection options.

For a particular form session, you can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14.

Form Sessions Waiting on Locks Chart
The Form Sessions Waiting on Locks chart shows the form sessions waiting on
database locks. You can set the collection options for this chart to limit the number
of rows returned.

You can drill down to the Session Details Chart on page A-14 or the Session
Statistics Chart on page A-14 for both the waiting and the locking sessions.

Form Sessions per User Chart
The Form Sessions per User chart shows the count of the active form sessions for a
user. A user will not appear in the chart unless that user has at least one active
session. You can set the collection options for this chart to limit the number of rows
returned.

For a given user, you can drill down to the Forms Sessions Details for User Chart on
page A-4.

Forms Sessions Details for User Chart
The Form Sessions Details for User chart is similar to the Current Form Sessions
Chart on page A-3 except that it only includes the form sessions for a specific user.

For a given form session, you can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14.

Form Sessions per Application Chart
The Form Sessions per Application chart shows the count of the active form
sessions for an application. An application will not appear in the chart unless that
application has at least one active session.

For a given application, you can drill down to the Forms Sessions Details for
Application Chart on page A-5.
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Forms Sessions Details for Application Chart
The Form Sessions Details for Application chart is similar to the Current Form
Sessions Chart on page A-3 except that it only includes the form sessions for a
specific application. You can set the collection options for this chart to limit the
number of rows returned.

For a given form session, you can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14.

Form Sessions per Responsibility Chart
The Form Sessions per Responsibility chart shows the count of the active form
sessions for a responsibility. A responsibility will not appear in the chart unless that
responsibility has at least one active session. You can set the collection options for
this chart to limit the number of rows returned.

For a given responsibility, you can drill down to the Forms Sessions Details for
Responsibility Chart on page A-5.

Forms Sessions Details for Responsibility Chart
The Form Sessions Details for Responsibility chart is similar to the Current Form
Sessions Chart on page A-3 except that it only includes the form sessions for a
specific responsibility.

For a given form session, you can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14.

Concurrent Requests Charts and Chart Groups
The Concurrent Requests charts and chart groups provide information about the
pending, running, and completed concurrent requests on the system.

Active Requests Chart Group
An active request is a concurrent request that is pending, standby, or running. This
chart group provides several different views of the volume of active requests on a
system. The following charts are included:

■ Active Requests by Status Chart on page A-6

■ Active Requests per User Chart on page A-6

■ Active Requests per Application Chart on page A-7
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■ Active Requests per Responsibility Chart on page A-8

Active Requests by Status Chart
The Active Requests by Status chart shows the numbers of pending, standby, and
running requests on the system.

You can drill down to the following charts:

■ All Standby Requests Chart on page A-11

■ All Pending Requests Chart on page A-11

■ All Running Requests Chart on page A-11

Active Requests per User Chart
The Active Requests per User chart shows the count of the active requests for a user.
A user will not appear in the chart unless that user has at least one active request.

For a given user, you can drill down to the following charts:

■ Active Requests Detail for User Group on page A-6

■ Standby Requests for User Chart on page A-6

■ Pending Requests for User Chart on page A-7

■ Running Requests for User Chart on page A-7

Active Requests Detail for User Group
This group contains the following charts:

■ Standby Requests for User Chart on page A-6

■ Pending Requests for User Chart on page A-7

■ Running Requests for User Chart on page A-7

Standby Requests for User Chart
The Standby Requests for User chart lists the standby requests for a specific user.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.
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Pending Requests for User Chart
The Pending Requests for User chart lists the pending requests for a specific user.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Running Requests for User Chart
The Running Requests for User chart lists the running requests for a specific user.

For a given request you can drill down to the Session Details Chart on page A-14 or
the Session Statistics Chart on page A-14. You can terminate the request by selecting
Terminate Request from the drill-down menu.

Active Requests per Application Chart
The Active Requests per Application chart shows the count of the active requests
for each application. An application will not appear in the chart unless that
application has at least one active request.

For a given application, you can drill down to the following charts:

■ Active Requests Detail for Application Group on page A-7

■ Standby Requests for Application Chart on page A-7

■ Pending Requests for Application Chart on page A-8

■ Running Requests for Application Chart on page A-8

Active Requests Detail for Application Group
This group contains the following charts:

■ Standby Requests for Application Chart on page A-7

■ Pending Requests for Application Chart on page A-8

■ Running Requests for Application Chart on page A-8

Standby Requests for Application Chart
The Standby Requests for Application chart lists the standby requests for a specific
application.
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For a given request you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Pending Requests for Application Chart
The Pending Requests for Application chart lists the pending requests for a specific
application.

For a given request you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Running Requests for Application Chart
The Running Requests for Application chart lists the running requests for a specific
application.

For a given request, you can drill down to the Session Details Chart on page A-14 or
the Session Statistics Chart on page A-14. You can terminate the request by selecting
Terminate Request from the drill-down menu.

Active Requests per Responsibility Chart
The Active Requests per Responsibility chart shows the count of the active requests
for a responsibility.

For a given responsibility, you can drill down to the following charts:

■ Active Requests Detail for Responsibility Group on page A-8

■ Standby Requests for Responsibility Chart on page A-9

■ Pending Requests for Responsibility Chart on page A-9

■ Running Requests for Responsibility Chart on page A-9

Active Requests Detail for Responsibility Group
This group contains the following charts:

■ Standby Requests for Responsibility Chart on page A-9

■ Pending Requests for Responsibility Chart on page A-9

■ Running Requests for Responsibility Chart on page A-9
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Standby Requests for Responsibility Chart
The Standby Requests for Responsibility chart lists the standby requests for a
specific responsibility.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Pending Requests for Responsibility Chart
The Pending Requests for Responsibility chart lists the pending requests for a
specific responsibility.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Running Requests for Responsibility Chart
The Running Requests for Responsibility chart lists the running requests for a
specific responsibility.

For a given request, you can drill down to the Session Details Chart on page A-14 or
the Session Statistics Chart on page A-14. You can terminate the request by selecting
Terminate Request from the drill-down menu.

Top Running Requests Chart
The Top Running Requests chart shows running requests consuming the greatest
amounts of a specified resource. You can choose from the following resources in the
collection options: Session UGA Memory, Session PGA Memory, CPU Used by this
Session, Physical Reads, Physical Writes, Open Cursors, User Commits, and User
Rollbacks. Also, the number of rows displayed by this chart can be limited in the
collection options.

For a particular request, you can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14. You can terminate the
request by selecting Terminate Request from the drill-down menu.

Longest Running Requests Chart
The Longest Running Requests chart lists the longest running request on a system.
The number of rows that are displayed by this chart can be limited in the collection
options.
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For a given request, the user can drill down to the Session Details Chart on
page A-14 or the Session Statistics Chart on page A-14. You can terminate the
request by selecting Terminate Request from the drill-down menu.

Requests Waiting on Locks Chart
The Requests Waiting on Locks chart shows the running requests waiting on
database locks. You can set the collection options for this chart to limit the number
of rows returned.

You can drill down to the Session Details Chart on page A-14 or the Session
Statistics Chart on page A-14 for both the waiting and the locking sessions.

Longest Pending Requests Chart
The Longest Pending Requests chart lists the requests that have been pending or on
standby for the longest time. The number of rows that are displayed by this chart
can be limited in the collection options.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Completed Requests by Status Chart
The Completed Requests by Status chart shows the numbers of requests that
completed with success, warning, and error.

You can drill down to the Completed with Warning Chart on page A-10 or the
Completed with Error Chart on page A-10.

Completed with Warning Chart
The Completed with Warning chart lists the requests that have completed with
warnings. The number of rows that are displayed by this chart can be limited in the
collection options.

Completed with Error Chart
The Completed with Error chart lists the requests that have completed with errors.
The number of rows that are displayed by this chart can be limited in the collection
options.
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All Standby Requests Chart
The All Standby Requests chart lists all standby requests. You can set the collection
options for this chart to limit the number of rows returned.

You can drill down to the Requests Waited On Chart on page A-11. You can also
cancel or toggle hold the request by selecting Cancel Request or Toggle Request
Hold from the drill-down menu.

All Pending Requests Chart
The All Pending Requests chart lists all pending requests.You can set the collection
options for this chart to limit the number of rows returned.

You can drill down to the Requests Waited On Chart on page A-11. You can also
cancel or toggle hold the request by selecting Cancel Request or Toggle Request
Hold from the drill-down menu.

All Running Requests Chart
The All Running Requests chart lists all running requests. You can set the collection
options for this chart to limit the number of rows returned.

You can drill down to the Session Details Chart on page A-14 or the Session
Statistics Chart on page A-14. You can terminate the request by selecting Terminate
Request from the drill-down menu.

Requests Waited On Chart
For a given pending or standby concurrent request X, the Requests Waited On chart
lists all the requests that must complete before request X can begin. For each request
that appears in this chart, a reason is given for its appearance. Valid reasons include:

■ Incompatible with request X

■ Single-threaded with request X

■ Parent waiting for child request X

■ Run-alone ahead of request X

You can also cancel or toggle hold the request by selecting Cancel Request or Toggle
Request Hold from the drill-down menu.
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Concurrent Managers Charts and Chart Group
The Concurrent Manager charts and chart group provide information about the
status of the concurrent managers on the system.

Concurrent Managers Status Group
The Concurrent Managers Status chart group gives an overview of the status of the
concurrent managers.

This group contains the following charts:

■ Pending Requests per Manager Chart on page A-12

■ Standby Requests per Manager Chart on page A-12

■ Running Requests per Manager Chart on page A-13

■ Processes per Manager Chart on page A-13

Pending Requests per Manager Chart
The Pending Requests per Manager chart shows the number of requests pending
for each manager. It does not include standby requests or requests on hold.

For a given manager, you can drill down to the Pending Request Details for
Manager Chart on page A-12.

Pending Request Details for Manager Chart
The Pending Request Details for Manager chart lists the pending requests for a
particular manager. You can set the collection options for this chart to limit the
number of rows returned.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Standby Requests per Manager Chart
The Standby Requests per Manager chart shows the number of standby requests for
each manager.

For a given manager, you can drill down to the Running Requests Details for
Manager Chart on page A-13.
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Standby Request Details for Manager Chart
The Standby Request Details for Manager chart lists the standby requests for a
particular manager. You can set the collection options for this chart to limit the
number of rows returned.

For a given request, you can drill down to the Requests Waited On Chart on
page A-11. You can also cancel or toggle hold the request by selecting Cancel
Request or Toggle Request Hold from the drill-down menu.

Running Requests per Manager Chart
The Running Requests per Manager chart shows the number of running requests
for each manager.

For a given manager, you can drill down to the Running Requests Details for
Manager Chart on page A-13.

Running Requests Details for Manager Chart
The Running Requests Details for Manager chart lists the running requests for a
particular manager. You can set the collection options for this chart to limit the
number of rows returned.

For a given request, you can drill down to the Session Details Chart on page A-14 or
the Session Statistics Chart on page A-14. You can terminate the request by selecting
Terminate Request from the drill-down menu.

Processes per Manager Chart
The Processes per Manager chart shows the number of  "worker" processes or
"slots" that each manager has to run requests.

For a given manager, you can drill down to the Process Details for Manager Chart
on page A-13.

Process Details for Manager Chart
The Process Details for Manager chart lists the concurrent processes for a particular
manager. You can set the collection options for this chart to limit the number of
rows returned.

For a given process, you can drill down to the Session Details Chart on page A-14 or
the Session Statistics Chart on page A-14.
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Sessions Blocking CRM/ICM Activity Chart
Because there is only one Internal Concurrent Manager (ICM) process and one
Conflict Resolution Manager (CRM) process, system performance is reduced when
either of these processes is blocked. The Sessions Blocking CRM/ICM Activity chart
shows the sessions currently blocking ICM and CRM activity.

You can drill down to the Session Details Chart on page A-14 or the Session
Statistics Chart on page A-14.

Database Session Charts
The Database Session charts described in this section provide information about
database sessions from the V$SESSION, V$SESSTAT, and V$SQLTEXT tables. These
charts are only accessible as drill-downs from other charts which provide the
context for the session.

Session Details Chart
The Session Details chart gives information about a single database session from the
V$SESSION table. For a given session, you can drill down to the Current SQL for
Session Chart on page A-14 or you can kill the session by selecting Kill Session from
the drill-down menu.

Session Statistics Chart
The Session Statistics chart gives the statistics from V$SESSTAT for a given database
session.

Current SQL for Session Chart
The Current SQL for Session chart gives the sql statement from V$SQLTEXT for a
given session.

Note: To collect certain session statistics, such as session CPU
time, the TIMED_STATISTICS database parameter must be set to
true in the init.ora file. Some overhead may be incurred if the
TIMED_STATISTICS parameter is set to true. If the parameter is set
to false, then certain statistics, such as session CPU time, will
always be 0. Refer to the Oracle database documentation for more
information about timed statistics.
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B
Remote Data Gatherer Configuration

The full functionality of the Management Pack for Oracle Applications is only
available for Concurrent Managers running on Windows NT 4.0, Solaris 2.6, and
Solaris 2.5.1. However, an alternative is available for using Performance Manager
and Capacity Planner against Concurrent Managers running on other platforms.
The alternative is to install the Data Gatherer and Agent Extensions on the
Enterprise Manager console machine, and point the Data Gatherer to the Oracle
Applications instance on a remote node.

To install the Intelligent Agent Extensions and Data Gatherer on the Enterprise
Manager console machine, do the following:

1. Insert the CD into the CD-ROM drive on the Enterprise Manager Console
machine.

2. Execute the setup script in the install directory for the platform on which you
are installing. This will start the Oracle Universal Installer.

3. At the Welcome screen, click Next.

4. At the File Locations screen, enter the Name and Path for the Oracle home
where the Data Gatherer and Intelligent Agent Extensions will reside. These
components must be installed in their own Oracle home.

Click Next to continue.

5. At the Available Products screen, select the Agent Extensions for Oracle
Applications 2.0.4 option. Selecting this option installs the 8.1.5 Intelligent
Agent, Data Gatherer, and necessary extensions.

Note: The use of any Concurrent Manager or node-related jobs
and events are not supported under this configuration.
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6. Continue clicking Next until the installation is complete.

7. Create a connection to each of the applications database instances you will be
managing by doing one of the following:

■ If installing on Windows NT:

Use the Net8 configuration tool, which is started at the end of the
installation, to create a connection to each of the applications database
instances you will be managing.

Open the tnsnames.ora file.

Copy the newly created tns entries.

Transfer the tns entries onto the machines which contain the Oracle
Management Server and Enterprise Manager console, pasting them into the
tnsnames.ora files.

■ If installing on Solaris:

Manually configure a tnsnames.ora entry for the applications database
instance in the Intelligent Agent Oracle home. This entry must be a fully
qualified name with the appropriate tns domain name appended. For
example, if the tns domain is "world", the tnsnames.ora entry must be
"instance_name.world". The tns domain can be found in the sqlnet.ora file
in the $Agent_Oracle_Home/network/admin/ directory.

8. Test your ability to connect to the applications database using SQL*Plus found
in the $Agent_Oracle_Home\bin\ directory.

At the command prompt, type sqlplus <user>/<password>@<apps_db>
and verify that a connection can be established.

Perform this step from each of the Oracle homes on your machine (including
the Oracle homes for Enterprise Manager, the repository database, and
Intelligent Agent).

9. Locate the oapps.ora file in the version 8.1.5 Intelligent Agent Oracle home and
add the SQL*Net alias name for the Oracle Applications database. The syntax of
the oapps.ora file is:

cmanager <apps_db> <unused apps env file> <unused apps startup info>

Variable Definition

<apps_db> Fully qualified tns alias name for the Applications database
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10. Start the Intelligent Agent and the Data Gatherer as described in the section
"Post-Installation Configuration" on page 2-1. If the Intelligent Agent is already
started, stop the Intelligent Agent and restart it.

11. In the Enterprise Manager console, select Navigator=>Discover Node. Enter the
name of the local machine. If the local machine already appears in the
Navigator, right-mouse click the node and select refresh.

12. Enterprise Manager now thinks that there is a concurrent manager on the local
machine even if there is none. You can now start Performance Manager or
Capacity Planner against this "concurrent manager" instance as if the instance
actually resides on your local machine.

Keep in mind, however, that this is not a supported configuration for running
concurrent manager related jobs and events. While the jobs and events will
appear as being available in the Enterprise Manager console, they will not
behave correctly. The Enterprise Manager Job and Event system only works
when the Intelligent Agent resides on the same node as the service being
managed.

<unused apps env file> Unused place holder argument for this configuration. Must
not be blank.

<Unused apps startup info> Unused place holder argument for this configuration. Must
not be blank.

IMPORTANT: The alias name for <apps_db> must be identical to
how it appears in the tnsnames.ora file in every Oracle home. For
example, if your tnsnames.ora file has an entry for
"OraAppsDB.world", the oapps.ora entry must also be
"OraAppsDB.world". An example using the syntax would be:

cmanager OraAppsDB.world xxxxx xxxxx

Variable Definition
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C
Troubleshooting

This appendix lists some of the problems you might encounter while using the
Management Pack for Oracle Applications, along with some possible solutions and
workarounds. Sections include:

■ Managed Node (Concurrent Manager Node)

■ Oracle Management Server Node (OMS)

■ Client Node

Table C–1 lists symptoms the Management Pack for Oracle Applications may
exhibit and refers you to the appropriate section for information. The table is also
divided into sections which reflect the nodes where the problems may occur.

Table C–1 Possible Problems Encountered While Using the Management Pack for
Oracle Applications

Managed Node (Concurrent Manager Node)

Cannot Start the Data Gatherer - Oracle Performance Utility Conflict on page C-2

Cannot Start the Data Gatherer - Reason Unknown on page C-3

Data Gatherer Not Responding or Not Running on page C-3

Cannot Determine Which Version of the Intelligent Agent Is Running on page C-4

Intelligent Agent Is Hung or Not Responding on page C-5

Oracle Management Server Node (OMS)

Problems Connecting to Oracle Management Server on page C-6

Client Node

Unable to Install Enterprise Manager on page C-6
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Managed Node (Concurrent Manager Node)
This section describes problems related to the Data Gatherer and the Intelligent
Agent and possible solutions.

Cannot Start the Data Gatherer - Oracle Performance Utility Conflict

Summary
The user cannot start the Data Gatherer on Windows NT. The user gets a message
stating: "The Oracle Performance Utility has been found. Please disable or deinstall
in order to start the Oracle Data Gatherer".

Reason
The Oracle Performance Utility is not compatible with the Oracle Data Gatherer.

The Oracle Performance Utility is a service that allows Windows NT users to
monitor their Oracle instance using the Microsoft NT Performance Monitor tool.
This utility is not compatible with the Oracle Data Gatherer.

Action
Rename or delete the registry key for Oracle Performance Utility. For example,
rename the following key from:

Unable to Connect to Repository When Using Performance Manager or Capacity Planner
on page C-7

Unable to Start Performance Manager in Context of the Console on page C-7

Error Connecting to Repository When Using Performance Manager on page C-8

Cannot Save Current Performance Manager Work on page C-8

Errors Occur When Attempting to Connect to Oracle Applications Instances on page C-9

Concurrent Manager Disappears from Navigator Tree on page C-9

Cannot Run the regappsmgmt.sh Scripts on page C-10

Invalid Credentials When Logging into Management Pack for Oracle Applications on
page C-10

Unable to Connect to a Service on page C-11

Table C–1 Possible Problems Encountered While Using the Management Pack for
Oracle Applications (Cont.)
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HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OracleOHOME80\Performance
to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OracleOHOME80\RENAMED_Performance

Cannot Start the Data Gatherer - Reason Unknown

Summary
The user cannot start the Data Gatherer.

Reason
The reason is unknown. See Cannot Start the Data Gatherer - Oracle Performance
Utility Conflict, since the diagnostic message indicating the problem may not
appear in all situations where the problem occurs.

Action
First, look at the $ORACLE_HOME/odg/log/alert_dg.log file for information.
Then run the Data Gatherer in debug mode and look for output messages
indicating the problem. Use the following command to run the Data Gatherer in
debug mode:

vppdc -console -debug

Data Gatherer Not Responding or Not Running

Summary
The Data Gatherer is either not responding or not running. The user is seeing the
following diagnostic messages:

VTM-0005: Error connecting to server
Make sure Data Gatherer is running and reconnect
Time-out while reading from Data Gatherer, connection lost for services
<service_name>

Note: You will not be able to run the Oracle Performance Utility
after this key has been renamed or deleted. To run the Oracle
Performance Utility, restore the registry key to its original state.
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This state may be further determined by running “vppcntl -ping” on the agent
node; if the Data Gatherer is not running, or is hung, this command will hang
indefinitely.

Reason
Unknown

Action
Determine whether the Data Gatherer is suspended or not running at all. Use the
appropriate operating system mechanism to locate the vppdc process, for example,
Task Manager on Windows NT or the ps command on UNIX.

If the vppdc process is suspended, kill the process. Start the Data Gatherer in debug
mode using the command:

vppdc -console -debug

If a particular action is causing the Data Gatherer to exit, the diagnostic messages
will help you identify the problem.

You could also kill the vppdc process, delete the alert_dg.log file, and restart the
Data Gatherer using the vppcntl -start command. Information about any
current problems will display in the alert_dg.log file located in the $ORACLE_
HOME/odg/log directory.

Cannot Determine Which Version of the Intelligent Agent Is Running

Summary
If you have multiple Oracle homes on Solaris, it is difficult to determine which
Intelligent Agent is being started because the version banner of the lsnrctl
command does not necessarily reflect the version of the Intelligent Agent the
command is starting.

Reason
Any version of the lsnrctl  command can be used to start any version of the
Intelligent Agent. The $ORACLE_HOME/network/agent/dbsnmp.ver file, which
is written at startup of the Intelligent Agent, contains the banner for the Intelligent
Agent. You can verify the time that the associated Intelligent Agent was started by
looking at the creation date for the dbsnmp.ver file.
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Action
The version of the Intelligent Agent that is started is determined by the $ORACLE_
HOME environment variable. Before invoking the lsnrctl  command, set the
ORACLE_HOME environment variable to correspond to the environment variable
of the Intelligent Agent you want to launch.

Refer to the Oracle Intelligent Agent User’s Guide for additional information.

Intelligent Agent Is Hung or Not Responding

Summary
Typing lsnrctl dbsnmp_status either hangs or reports that the Intelligent
Agent is not running, though the execution of the ps -ef | grep dbsnmp
command shows one or more dbsnmp processes running.

Reason
Unknown

Action
Terminate the two dbsnmp processes and restart the Agent. After terminating the
dbsnmp process, all lsnrctl dbsnmp_*  commands should work correctly.

However, in extreme cases, the Intelligent Agent may still not restart properly. If the
Agent will not run normally, kill the dbsnmp processes, remove all of the .q files in
the $ORACLE_HOME/network/agent directory, and then restart the Agent.

Examine the Agent log files (dbsnmpw.log and dbsnmpc.log) in the $ORACLE_
HOME/network/log direcotry for additional diagnostic information. The
dbsnmpw.log file is the log file for the Agent worker process and the dbsnmpc.log
is the log file for the Agent communication process.

Warning: If you perform the steps outlined in the previous
sentence, you will lose all existing states for the Agent relating to
outstanding jobs and events. You must then manually deregister
these orphaned events from the Oracle Enterprise Manager
console. You can reregister these events if you want.
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Oracle Management Server Node (OMS)

Problems Connecting to Oracle Management Server

Summary
User cannot connect to the Oracle Management Server.

Reason
Unknown

Action
Verify that the maximum number of sessions on the Oracle Management Server
repository (database) has not been exceeded. If needed, increase the  "processes = "
init.ora parameter for this database, and then stop and restart the database.

Use SQL*Plus or another tool to verify that you can connect from the Oracle
Management Server ORACLE_HOME to the database being used as the Oracle
Management Server repository.

Client Node

Unable to Install Enterprise Manager

Summary
During the installation process, the user attempts to install an Enterprise Manager
pack which includes the Enterprise Manager or the Performance Manager or both
into an Oracle home which is not the same as the Oracle home in which the current
Enterprise Manager and Performance Manager reside.

Reason
Enterprise Manager release 2.0 and Performance Manager require that there be only
one existing copy of Enterprise Manager and Performance Manager on a system.

Action
Install the new pack in the same Oracle home in which the previous Enterprise
Manager and Performance Manager resided.
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Unable to Connect to Repository When Using Performance Manager or Capacity
Planner

Summary
The user cannot connect to the repository when using either the Performance
Manager or Capacity Planner applications.

Reason
An empty connect string was given when the Oracle Management Server repository
was created. Alternatively, an unqualified DNS hostname was given at the time of
creation and you are trying to connect from a separate DNS domain.

Action
Recreate the repository and explicitly specify the connect string even though you
want to use the local database. If you are connecting to the Oracle Management
Server from outside the DNS domain in which the Oracle Management Server
repository was created, use a fully qualified hostname when creating the repository
(for example, use omshost.acme.com not omshost).

Unable to Start Performance Manager in Context of the Console

Summary
The user cannot start Performance Manager in the context of the Oracle Enterprise
Manager console.

Reason
Performance Manager makes a direct connection to the Oracle Enterprise Manager
repository based on a connect string Performance Manager retrieves from the
Oracle Management Server. This process fails when invoked from hosts in external
DNS domains if you do not specify a fully qualified connect string during the
repository creation process (in the Configuration Assistant). Also, this process fails
if the local tnsnames.ora file does not have an entry for the database being used for
the Oracle Management Server repository.

Action
Drop and recreate the repositories with a connect string to the repository database.
This also includes the situation where the repository and the database are on the
same machine.
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Verify that the local tnsnames.ora file contains the correct Net8 connect alias by
using SQL*Plus or another tool to connect to the Oracle Management Server
repository database.

Error Connecting to Repository When Using Performance Manager

Summary
The user receives the following messages when attempting to connect to the
repository when using Performance Manager:

VTD-0057: Error connecting to repository.
Exception VdbLostConnectionException{wstring reason = "ORA-12203: TNS:unable to
connect to destination"; long oracleError=12203;}

When the user continues, the following message appears:

VTD-0058: Repository-based operations will not be available.

Reason
Unknown

Action
Use the vtm -debug command from the command line to run Performance
Manager in tracing mode. Then connect to the Oracle Management Server and
search the trace output for the service Performance Manager is using to connect to
the repository.

This symptom may be caused by incorrect Net8 configuration on the client node
where you are experiencing this behavior. This symptom can occur if you used a
Net8 connect alias (for example, mydatabase.world), instead of the colon-separated
(for example, myhost.acme.com:1521:mySID) syntax when you created the Oracle
Management Server repository.

Use SQL*Plus or another tool to verify that you can connect from this node to the
database being used as the Oracle Management Server repository. Use the exact
Net8 connect alias (for example, foo.world) you used when creating the repository.

Cannot Save Current Performance Manager Work

Summary
User cannot save work performed in Performance Manager.
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Reason
If you start Performance Manager in standalone mode and Performance Manager is
connected to a database directly without using the Oracle Management Server, you
are not able to save your work.

Action
You can save your work to the repository by starting Performance Manager in the
context of the Oracle Enterprise Manager console. Follow the menu path
Tools=>Application Management=>Performance Manager.

Errors Occur When Attempting to Connect to Oracle Applications Instances

Summary
User is attempting to connect to an Oracle Applications instance using Performance
Manager or Capacity Planner and receives the following error message:

Error: A required patch has not been applied to this Oracle Applications
instance

Reason
The patch for Oracle Applications bug #730116 for Oracle Applications version 10.7
or the patch for Oracle Applications bug #901809 for Oracle Applications version
11.0 was not applied to the Applications instance.

Action
Apply the patch for bug #730116 or bug #901809 to the Applications instance.

The Solaris version of these patches is shipped on this CD-ROM in the top-level
directory "Applications Patches" for your convenience. A listing of the ARU patch
number corresponding to this bug for other platforms is attached to the release note
for this product.

Concurrent Manager Disappears from Navigator Tree

Summary
Concurrent Manager no longer appears in the Performance Manager or Capacity
Planner navigator tree.
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Reason
Installing the Diagnostic Pack release 2.0.4.0.0 after the Management Pack for
Oracle Applications is installed downgrades Capacity Planner and Performance
Manager to an older version.

Action
Reinstall the Management Pack for Oracle Applications kit client components using
the Oracle Installer provided in the Management Pack for Oracle Applications kit.
The installer will only upgrade the components that were downgraded during the
Diagnostic Pack installation.

Cannot Run the regappsmgmt.sh Scripts

Summary
The user cannot run the regappsmgmt.sh  script.

Reason
The version of the jre referred to in the script does not recognize the -native
qualifier. The path is referring to an old jre. The Management Pack for Oracle
Applications installed the correct jre but the script points to the wrong jre.

Action
The jre installed with the Management Pack for Oracle Applications should be
version 1.1.7. Type the command jre -help . The result displays the jre version
number. Locate the correct jre on your system. Modify the path in the script to point
to the correct jre.

Invalid Credentials When Logging into Management Pack for Oracle Applications

Summary
When starting Management Pack for Oracle Applications tools, user receives errors
stating that the credentials are invalid, even though the user verified that the
credentials were correct.

Reason
The "invalid credentials" error may be misleading. This error may be returned if
there are no available process slots for the database to establish a new connection,
or if there are Net8 configuration problems.
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Action
Increase the number of DB sessions to at least 200 (more if needed) by changing the
"processes =" init.ora parameter of the database. Stop and restart the database.

Verify that Net8 connectivity is working correctly.

Unable to Connect to a Service

Summary
While viewing charts from a service, the following message appears indicating that
the connection to the service has been lost.

VTM-0002: Error displaying chart Pending Requests per Manager
Make sure Data Gatherer is running and reconnect
Error reading response from Data Gatherer, connection lost for service NT110

Attempts to reconnect to the service fail.

Reason
The Data Gatherer has stopped running.

Action
Restart the Data Gatherer.
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Active Requests by Status chart, A-6
Active Requests chart group, A-5
Active Requests Detail for Application chart

group, A-7
Active Requests Detail for Responsibility chart

group, A-8
Active Requests Detail for User chart group, A-6
Active Requests per Application chart, A-7
Active Requests per Responsibility chart, A-8
Active Requests per User chart, A-6
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data to an existing analysis, 4-15
agent

UNIX
checking status, 2-9, 2-15
starting, 2-9, 2-15
stopping, 2-9, 2-15

Agent data gathering service, 3-2
checking the status of, 4-13
troubleshooting, 4-13

All Pending Requests chart, A-11
All Running Requests chart, A-11
All Standby Requests chart, A-11
analysis

adding data from other classes to, 4-22
creating a copy of an existing, 4-18
creating by browsing collected data, 4-15
deleting, 4-20
extrapolate to time, 4-24
extrapolate to value, 4-24
generating a report for an, 4-27
modifying the selection criteria for an

existing, 4-22
printing, 4-27
renaming an existing, 4-19
saving the results of, 4-26
viewing and modifying an existing, 4-17

analysis results
including in charts, 4-25
saving, 4-26

analyzing
collected historical data, 4-13
historical data collections

using extrapolation analysis, 4-24
annotation box

displaying in an analysis chart, 4-25
moving in an analysis chart, 4-26

Application Object Library tables, 5-1
auto-scaling

applying to chart data, 4-24

B
bar charts, 3-11
browsing collected data, 4-15

C
chart groups, 3-10

Active Requests chart group, A-5
Active Requests Detail for Application chart

group, A-7
Active Requests Detail for Responsibility chart

group, A-8
Active Requests Detail for User chart

group, A-6
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Concurrent Manager chart group, A-12
Concurrent Manager Status chart group, A-3,

A-12
Concurrent Requests chart groups, A-5
System Activity Overview chart group, A-2
System Overview chart groups, A-2
Top Resource Consumers chart group, A-2

charts
Active Requests by Status chart, A-6
Active Requests per Application chart, A-7
Active Requests per Responsibility chart, A-8
Active Requests per User chart, A-6
All Pending Requests chart, A-11
All Running Requests chart, A-11
All Standby Requests chart, A-11
auto-scaling the data included in, 4-24
Completed Requests by Status chart, A-10
Completed with Error chart, A-10
Completed with Warning chart, A-10
Concurrent Manager charts, A-12
Concurrent Requests charts, A-5
constraints, 3-11
Current Form Sessions chart, A-3
customizing the annotation box for

analyses, 4-26
Database session charts, A-14
displaying or hiding the chart legend, 4-24
drilling down, 3-12
excluding data points from, 4-23
Form Sessions and Concurrent Requests

chart, A-2
Form Sessions charts, A-3
Form Sessions per Responsibility chart, A-5
Form Sessions per User chart, A-4
Form Sessions Waiting on Locks chart, A-4
formats of, 3-10, 3-12
Forms Sessions Details for Responsibility

chart, A-5
Forms Sessions Details for User chart, A-4, A-5
generating reports for, 3-13
getting help on, 3-13
hiding the chart legend, 4-24
Idle Form Sessions chart, A-4
including analysis results in, 4-25
Longest Pending Requests chart, A-10

Longest Running Requests chart, A-9
orientations, 3-12
Pending Request Details for Manager

chart, A-12
Pending Requests for Application chart, A-8
Pending Requests for Responsibility chart, A-9
Pending Requests for User chart, A-7
Pending Requests per Manager chart, A-12
printing, 3-13
Process Details for Manager chart, A-13
Processes per Manager chart, A-13
removing lines from, 4-23
Requests Waited On chart, A-11
Requests Waiting on Locks chart, A-10
Running Requests Details for Manager

chart, A-13
Running Requests for Application chart, A-8
Running Requests for Responsibility chart, A-9
Running Requests for User chart, A-7
Running Requests per Manager chart, A-13
scaling the data in, 4-24
selecting a line in, 4-21
Session Details chart, A-14
Session Statistics chart, A-14
Sessions Blocking CRM/ICM Activity

chart, A-14
sorting data in table, 3-12
Standby Request Details for Manager

chart, A-13
Standby Requests for Application chart, A-7
Standby Requests for Responsibility chart, A-9
Standby Requests for User chart, A-6
Standby Requests per Manager chart, A-12
System Overview charts, A-2
Top Form Sessions chart, A-3
Top Running Requests chart, A-9
viewing the values of data points in, 4-21

checking status
Intelligent Agent

UNIX, 2-9, 2-15
class

contents of data tables in the historical
database, 4-29

definition of, 4-11
modifying selection criteria for including in an
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analysis, 4-22
names of data tables in the historical

database, 4-28
specifying for historical data collection, 4-11
specifying selection criteria for including in an

analysis, 4-16
understanding the data tables in the historical

database, 4-28
class reference table

understanding, 4-28
collected data

browsing, 4-15
collection frequency

specifying for a service, 4-7
collection problems

troubleshooting, 4-13
Completed Requests by Status chart, A-10
Completed with Error chart, A-10
Completed with Warning chart, A-10
computing statistics

using SQL ANALYZE command, 5-1
concurrent manager balancing, 5-2
Concurrent Manager chart group, A-12
Concurrent Manager charts, A-12
Concurrent Manager Disk Free, 6-7
concurrent manager specialization, 5-3
Concurrent Manager Status chart group, A-3, A-12
Concurrent Manager UpDown, 6-7
Concurrent Manager Utilization by Hour (24 x 7)

report, 5-3
Concurrent Requests chart groups, A-5
Concurrent Requests charts, A-5
configuring

the Agent data gathering service, 1-2
Console

starting
from command line, 2-19
from Windows Start menu, 2-19

constraints
selecting chart, 3-11

copying an analysis, 4-18
CPU Paging Rate, 6-11
CPU Paging Rate event, 6-11
CPU Utilization, 6-10
CPU Utilization event, 6-10

creating
a copy of an analysis, 4-18
an analysis, 4-14

CRM Waiting on a Lock, 6-5
Current Form Sessions chart, A-3

D
data

determining what is being collected, 4-12
purging policies, 5-2
selecting collected, 3-10

data aggregation
time intervals when it occurs, 4-8

data class
definition of, 4-11
specifying for historical data collection, 4-11

data collection
See historical data collection

data completeness, 5-2
Data Gatherer Alert event, 6-8
data item

definition of, 4-11
selecting for collection, 4-12
stopping collection for a, 4-12

data point
displaying a currently excluded point in a

chart, 4-23
excluding from a chart, 4-23
viewing the value of a, 4-21

data samples
specifying the length of time between, 4-7
specifying the number to collect for a time

interval, 4-7
data source

selecting for collection, 4-12
stopping collection for a, 4-12

data sources
definition of, 4-12
examples of, 4-12
selecting, 3-10

Database session charts, A-14
deleting

an analysis, 4-20
Disk Full, 6-9
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Disk Full (%), 6-9
Disk Full (%) event, 6-9
Disk Full event, 6-7, 6-9
displaying

a chart legend, 4-24
an annotation box for an analysis, 4-25
existing user-defined analyses, 4-17
predefined analyses, 4-18

drill-down charts, 3-12

E
excluding a data point from a chart, 4-23
extrapolation analysis

specifying and performing, 4-25
to a time, 4-24
to a value, 4-24

F
FND_APPLICATION_TL table, 5-1
FND_CONCURRENT_PROCESSES table, 5-2
FND_CONCURRENT_PROGRAMS table, 5-2
FND_CONCURRENT_PROGRAMS_TL table, 5-2
FND_CONCURRENT_QUEUES table, 5-2
FND_CONCURRENT_QUEUES_TL table, 5-2
FND_CONCURRENT_REQUESTS table, 5-2
FND_LOOKUP_VALUES table, 5-1
FND_USER table, 5-2
Form Sessions and Concurrent Requests chart, A-2
Form Sessions charts, A-3
Form Sessions per Responsibility chart, A-5
Form Sessions per User chart, A-4
Form Sessions Waiting on Locks chart, A-4
Forms Sessions Details for Responsibility

chart, A-5
Forms Sessions Details for User chart, A-4, A-5

G
green dot on class icon in navigator panel

meaning of, 4-12

H
help

accessing for Oracle Capacity Planner, 4-3
for charts, 3-13

hiding
a chart legend, 4-24
the list of predefined analyses, 4-18

hierarchical charts, 3-11
historical data collection

aggregation of data in, 4-8
setting up a, 4-4
specifying a service for, 4-5
specifying the age of the data saved for

analysis, 4-10
specifying the classes of data to collect, 4-11
stopping for a class of data, 4-12

historical database
contents of data tables for classes in, 4-29
names of data tables for a class, 4-28
specifying the location of a, 4-7
understanding the class reference table, 4-28
understanding the data tables for a class

in, 4-28
understanding the logical structure of, 4-27
understanding the service reference table, 4-28
unsupported modifications to, 4-28

horizontal orientation
of a chart, 3-12

I
ICM Waiting on a Lock, 6-6
Idle Form Sessions chart, A-4
Inactive Request Pending, 6-3
installing

the Agent data gathering service, 1-2
Intelligent Agent

UNIX, 2-9
starting, 2-9, 2-15
stopping, 2-9, 2-15
verifying status, 2-9, 2-15

Intelligent Agent Extensions
installing, B-1
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L
line charts, 3-11
load frequency

specifying for a service, 4-8
load problems

troubleshooting, 4-13
loader passes

selecting the length of time between, 4-8
selecting the number for a time interval, 4-8

log file for Agent data gathering service, 4-13
Long Running Requests report, 5-3
Longest Pending Requests chart, A-10
Longest Running Requests chart, A-9

M
Management Server

selecting from login dialog, 2-19
modifying

existing analysis, 4-17
selection criteria for a class of data in an analysis

chart, 4-22
text in an annotation box, 4-26

moving
annotation box in an analysis chart, 4-26

N
navigating within Oracle Performance

Manager, 3-4
Net8 configuration, 2-4, 2-5

O
oapps.ora file, 2-5
oemapp console command, 2-19
Oracle Application Object Library tables, 5-1
Oracle Capacity Planner

functions of, 4-1
starting, 4-2
two-step process for using, 4-4
usage scenarios for, 4-2

Oracle Performance Manager
functions of, 3-1
usage scenarios for, 3-2

Oracle Performance Utility, C-2

P
Pending Concurrent Request Backlog, 6-5
Pending Request Details for Manager chart, A-12
pending requests, A-2
Pending Requests for Application chart, A-8
Pending Requests for Responsibility chart, A-9
Pending Requests for User chart, A-7
Pending Requests per Manager chart, A-12
performance

improving in retrieving data, 5-1
performance statistics

projecting, 4-24
performance when using Tuning Assistant, 5-1
pie charts, 3-10
predefined analyses

displaying or hiding the list of, 4-18
printing

a chart, 3-13
an analysis chart, 4-27

problems
troubleshooting, 4-13

Process Details for Manager chart, A-13
Processes per Manager chart, A-13
purging

determining how much historical data to keep
before, 4-10

purging concurrent processing tables, 5-2
purging data

policies, 5-2

R
recording chart data, 3-13
recordings

playing back, 3-15
removing, 3-15
starting, 3-14
stopping, 3-14

Recordings folder, 3-5
reducing wait time, 5-3
removing

a line from a chart, 4-23



Index-6

renaming
an analysis, 4-19

report
generating for an analysis report, 4-27

reports
Concurrent Manager Utilization by Hour (24 x 7)

report, 5-3
generating for charts, 3-13
Long Running Requests, 5-3
Requests that Ran, 5-3
Requests that Waited, 5-2
Short Running Requests that Waited, 5-3
Waiting Requests by Hour (24 x 7), 5-2

repository
automatically created, 3-4
not connected to, 3-4

Request Error Rate, 6-3
Request Pending Time, 6-4
request schedules

tuning, 5-2
Request Warning Rate, 6-4
Requests that Ran report, 5-3
Requests that Waited report, 5-2
Requests Waited On chart, A-11
Requests Waiting on Locks chart, A-10
Runalone Request Submitted, 6-2
Running Requests Details for Manager chart, A-13
Running Requests for Application chart, A-8
Running Requests for Responsibility chart, A-9
Running Requests for User chart, A-7
Running Requests per Manager chart, A-13

S
saving

analysis results, 4-26
security login, 2-19
selection criteria

modifying for class data in an analysis, 4-22
specifying for class data in an analysis, 4-16

service
selecting for historical data collection, 4-5
specifying the classes of data to collect

from, 4-11
specifying the collection frequency for, 4-7

specifying the load frequency for, 4-8
service reference table

understanding, 4-28
Session Details chart, A-14
Session Statistics chart, A-14
Sessions Blocking CRM/ICM Activity chart, A-14
Short Running Requests that Waited report, 5-3
SQL ANALYZE command, 5-1
Standby Request Details for Manager chart, A-13
standby requests, A-1
Standby Requests for Application chart, A-7
Standby Requests for Responsibility chart, A-9
Standby Requests for User chart, A-6
Standby Requests per Manager chart, A-12
starting

Console
from command line, 2-19
from Windows Start menu, 2-19

Oracle Capacity Planner, 4-2
starting Tuning Assistant

from Oracle Enterprise Manager, 5-3
from Start menu, 5-4

stopping
collection of data for a data source or data

item, 4-12
strip charts, 3-11
Swap Full, 6-8, 6-10
Swap Full event, 6-10
System Activity Overview chart group, A-2
System Overview chart groups, A-2
System Overview charts, A-2

T
table charts, 3-11

sorting data in, 3-12
tables

Application Object Library tables, 5-1
FND_APPLICATION_TL, 5-1
FND_CONCURRENT_PROCESSES, 5-2
FND_CONCURRENT_PROGRAMS, 5-2
FND_CONCURRENT_PROGRAMS_TL, 5-2
FND_CONCURRENT_QUEUES, 5-2
FND_CONCURRENT_QUEUES_TL, 5-2
FND_CONCURRENT_REQUESTS, 5-2
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FND_LOOKUP_VALUES, 5-1
FND_USER, 5-2
Oracle Application Object Library tables, 5-1
purging concurrent processing, 5-2

Top Form Sessions chart, A-3
Top Resource Consumers chart group, A-2
Top Running Requests chart, A-9
troubleshooting

collection and load problems, 4-13
Tuning Assistant

starting from Oracle Enterprise Manager, 5-3
starting from Start menu, 5-4
usage scenarios, 5-2

Tuning Assistant performance, 5-1
tuning request schedules, 5-2

U
usage scenarios

for Oracle Capacity Planner, 4-2
for Oracle Performance Manager, 3-2
for Tuning Assistant, 5-2

using Oracle Capacity Planner help, 4-3

V
vertical orientation

of a chart, 3-12
viewing

an existing analysis, 4-17
the selection criteria for a class of data in an

analysis, 4-22

W
wait time

reducing, 5-3
Waiting Requests by Hour (24 x 7) report, 5-2
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